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PREFACE
Every effort has been made to ensure that the information in this document is complete, 
accurate, and up-to-date. The manufacturer assumes no responsibility for the results of 
errors beyond its control. The manufacturer also cannot guarantee that changes in software 
and equipment made by other manufacturers and referred to in this guide will not affect 
the applicability of the information in it. Mention of software products manufactured by 
other companies does not necessarily constitute endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful 
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or 
completeness of the information contained herein.

The most up-to-date drivers and manuals are available from:

http://www.oki.com/printing/
Copyright © 2016. Oki Data Corporation All rights reserved.

OKI is a registered trademark of Oki Electric Industry Co., Ltd.

Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation.

Apple, Macintosh, Mac and Mac OS are trademarks of Apple Inc.

Other product names and brand names are registered trademarks or trademarks of their 
proprietors.

iPad, iPhone, iPod, and iPod touch are trademarks of Apple Inc., registered in 
the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of 
Apple Inc.

As an Energy Star Program Participant, the manufacturer has determined that 
this product meets the Energy Star guidelines for energy efficiency.

This product complies with the requirements of the Council Directives 2014/30/
EU (EMC), 2014/35/EU (LVD), 1999/5/EC (R&TTE), 2009/125/EC (ErP) and 
2011/65/EU(RoHS), as amended where applicable, on the approximation of the 
laws of the member states relating to Electromagnetic Compatibility, Low 
Voltage, Radio & Telecommunications Terminal Equipment, Energy related 
Products and Restriction on the use of certain Hazardous Substances in 
electrical and electronic equipment.

The following cables were used to evaluate this product to achieve EMC directive 
2014/30/EU compliance and configurations other than this may affect that compliance.

CABLE TYPE LENGTH 
(METRE)

CORE SHIELD

Power 1.8

USB 5.0

LAN 7.0

Telephone 7.0

AirPrintTM

AirPrint logoTM

iPad®

iPhone®

iPod®

iPod touch®
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EMERGENCY FIRST AID
Take care with toner powder:

If swallowed, give small amounts of cold water and seek medical 
attention. DO NOT attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical 
attention.

If it gets into the eyes, flush with large amounts of water for at least 15 
minutes keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk 
of staining skin or clothing.

MANUFACTURER
Oki Data Corporation,
4-11-22 Shibaura, Minato-ku,
Tokyo 108-8551,
Japan

IMPORTER TO THE EU/AUTHORISED REPRESENTATIVE
Oki Europe Limited

Blays House
Wick Road
Egham
Surrey, TW20 0HJ
United Kingdom

For all sales, support and general enquiries contact your local distributor.

ENVIRONMENTAL INFORMATION

  w

ww.oki.com/printing/
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This product contains software developed by the Heimdal Project.

Copyright (c) 1995 - 2008 Kungliga Tekniska Högskolan 

(Royal Institute of Technology, Stockholm, Sweden). 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

3. Neither the name of the Institute nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission. 

THIS SOFTWARE IS PROVIDED BY THE INSTITUTE AND CONTRIBUTORS “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE INSTITUTE OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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NOTES, CAUTIONS AND WARNINGS

For the protection of your product, and in order to ensure that you benefit from its full 
functionality, this model has been designed to operate only with genuine original toner 
cartridges. Any other toner cartridge may not operate at all, even if it is described as 
“compatible”, and if it does work, your product's performance and print quality may be 
degraded.

Use of non-genuine products may invalidate your warranty.

Specifications subject to change without notice. All trademarks acknowledged.

NOTE
A note provides additional information to supplement the main text.

CAUTION!

A caution provides additional information which, if ignored, may 
result in equipment malfunction or damage.

WARNING!

A warning provides additional information which, if ignored, may 
result in a risk of personal injury.
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ABOUT THIS GUIDE

DOCUMENTATION SUITE

This guide is part of a suite of online and printed documentation provided to help you 
become familiar with your product and to make the best use of its many powerful features. 
The documentation is summarised below for reference and is found on the manuals DVD 
unless indicated otherwise:

> Installation Safety booklet: provides information for safe use of your product.

This is a paper document that is packaged with the product and should be read before 
setting up your machine.

> Set-up guide: describes how to unpack, connect and turn on your product.

This is a paper document that is packaged with the product.

> User’s Guide: helps you become familiar with your product and make the best use 
of its many features. Also included are guidelines for troubleshooting and 
maintenance to ensure that it performs at its best. Additionally, information is 
provided for adding optional accessories as your printing needs evolve.

> Configuration Guide: provides machine, fax and network configuration 
information.

> On-line Help: on-line information accessible from the printer driver and utility 
software.

PURPOSE OF THIS GUIDE

The purpose of this guide is to provide you with in-depth information on how to use your 
machine efficiently and effectively for printing, copying, scanning and faxing.

Depending on your OS, model or version, the description on this document may be 
different.

NOTE
Images used in this manual may include optional features that your product 
does not have installed.

NOTE
The User Guide assumes that the machine has been set up and fully 
configured. Refer to the Setup Guide and Configuration Guide for guidance.
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ON-LINE USAGE

This guide is intended to be read on screen using Adobe Reader. Use the navigation and 
viewing tools provided in Adobe Reader.

There are many cross-references within this book, each highlighted as blue text. When you 
click on a cross-reference the display will instantly jump to the part of the manual 
containing the referenced material. 

By using the  button in Adobe Reader, you can navigate directly back to where you were 
before.

You can access specific information in two ways:

> In the list of bookmarks down the left hand side of your screen, click on the topic of 
interest to jump to the required topic. (If the bookmarks are not available, use the 
“Contents” on page 5.)

> In the list of bookmarks, click on Index to jump to the Index. (If the bookmarks are 
not available, use the “Contents” on page 5.) Find the term of interest in the 
alphabetically arranged index and click on the associated page number to jump to 
the page containing the term.

PRINTING PAGES

The whole manual, individual pages, or sections may be printed. The procedure is:

1. From the toolbar, select File > Print (or press the Ctrl + P keys).

2. Choose which pages you wish to print:

(a) All pages, (1), for the entire manual.

(b) Current page, (2), for the page at which you are looking.

(c) Pages from and to, (3), for the range of pages you specify by entering their 
page numbers.

(d) Click OK.

1 
2 
3 
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INTRODUCTION
Congratulations on choosing this Multi Function Product (MFP). It is designed with advanced 
features, to give you clear, vibrant color prints and crisp black and white pages at high 
speed on a range of office print media.

With this MFP, you can instantly scan paper-based documents and deliver the electronic 
image to various destinations including E-mail addresses, printers, ftp servers or someone 
else's computer on the network. This MFP also has a “walk-up” fax facility allowing you to 
send your documents to a destination fax number instantly.

Your MFP includes these features:

> Multi-tasking to allow scanning one job while printing another to ensure greater 
productivity.

> Digital Copying - An intuitive control panel, makes digital copying fast and easy.

> Up to 600 x 600dpi (dots per inch) copy resolution.

> Actkey utility - enables the MFP to receive one key touch commands from a locally 
connected computer (“pull scan”).

> Scan to E-mail - Connected to an Ethernet network and a SMTP server, this MFP 
allows you to transmit document(s) over the internet via E-mail. With a touch of the 
E-mail on-screen button and the selection of your recipients' E-mail addresses, the 
document(s) is/are first scanned and converted into an image file, and then 
transmitted to remote recipients within minutes.

> Scan to Shared Folder - Allows you to send scanned documents to a server or a 
personal computer's file folder over an intranet with FTP (File Transfer Protocol), 
HTTP (Hypertext Transfer Protocol), CIFS (Common Internet File System) protocol. 
The scan to filing feature removes the need for the mail server to handle large 
attachments.

> Multiple Pages Sending - With the Auto Document Feeder (ADF), the MFP allows a 
stack of up to 50 page document(s) to be continuously scanned.

> Faxing - An intuitive control panel, makes direct faxing fast and easy.

> Advanced fax transmission and reception, including delayed transmissions, sending 
to multiple locations, confidential transmission and reception, and polling.

> Address Book/Phone Book/Profiles Managing - This provides a convenient way to 
manage all the E-mail addresses, fax numbers and profiles (filing destinations).

> ProQ/High Quality, multi-level technology produces subtler tones and smoother 
gradations of color to lend photographic quality to your documents.

> 600 x 600, 1200 x 600 dpi (dots per inch) and ProQ/High Quality print resolution for 
high quality image production showing the finest detail.

> Internet Protocol version 6 (IPv6).

> Single Pass color Digital LED technology for high speed processing of your printed 
pages.

> PostScript 3, PCL 5C, PCL 6, IBM PPR and Epson FX emulations for industry standard 
operation and wide compatibility with most computer software.

> 10Base-T and 100Base-TX network connection lets you share this valuable resource 
among users on your office network.

> Photo Enhance mode to improve printouts of photographic images (not available on 
PS drivers).

> Automatic two-sided (duplex) printing for economical use of paper and compact 
printing of larger documents.
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Additionally, the following optional features are also available:

> Additional paper tray for loading a further 530 sheets to minimise operator 
intervention, or different paper stocks for letterhead stationery, alternative paper 
sizes or other print media.

> Additional memory allows printing of more complex pages. For example, high 
resolution banner printing.

> Four modes of toner save function (Default: Off, Low, Middle, High) are available 
when using Copy/DirectPrint/Fax function.

> Can use wireless LAN.

> Can use AirPrint. Can print from iPhone, iPad, iPod touch, or other iOS device 
without installing printer drivers.
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OVERVIEW

FRONT VIEW

1. ADF unit.
2. ADF paper tray.
3. Operator panel.

Menu driven operator controls and LCD panela.
4. Output tray (face down).

Standard printed copy delivery point. Holds up to 
150 sheets at 80g/m².

5. Paper tray.
Standard paper tray. Holds up to 250 sheets of 
80g/m² paper.

6. Multi purpose tray.
Used for feeding heavier paper stocks, envelopes 
and other special media. Also for manual feeding 
of single sheets when required.

a. The display language can be changed to show different languages. (see “Changing the display 
language” on page 17).

7. Multi-purpose tray release recess.
8. Output tray release button.
9. Document glass.
10. ADF document glass.
11. Document cover.
12. LED heads.
13. Fuser release levers.
14. Toner cartridges (C,M,Y,K).
15. ID unit.
16. Power Switch.
17. USB memory port.
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REAR VIEW

When the rear output tray is folded down paper exits the printer through the rear of the 
printer and is stacked here face up. This is mainly used for heavy print media. When used 
in conjunction with the multi purpose feed tray, the paper path through the printer is 
essentially straight. This avoids bending the paper around curves in the paper path and 
enables feeding of up to 220g/m² media.

1. Access panel. 
2. AC power socket.
3. USB interface.

4. Network interface.a

a. The Network Interface may have a protective “plug” which must be 
removed before connection can be made.

5. Rear output tray (face up stacker).
6. LINE connection.
7. TEL connection.
8. Wireless LAN I/F Cover.

1

5

4

3

76

8

2
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CONTROL PANEL

REF. DESCRIPTION

1. Liquid crystal display (LCD)
Displays operating instructions and status of your machine.

2. Panel adjust recess
The LCD panel can be swivelled upwards from its base position for ease of use.

3. Main function buttons
COPY: Pressing this button selects copy mode. This allows you to control the copying process 
whereby documents to be copied are scanned in the scanner unit (document glass or ADF) and the 
copies are automatically printed in the printer unit.
SCAN: Pressing this button gives access to several send modes. These allow you to select and 
control the process whereby a document is scanned and the scanned data is sent: by email as an 
attachment, to a local PC, to a network PC, to a USB memory stick. It also allows you to arrange for 
a document to be scanned from a remote PC.
PRINT: Pressing this button selects print mode. This allows you to select and print out a stored job, 
an encrypted print job or a job stored on a USB memory stick. It also allows you to print out a job 
list of all recent prints, or switch the machine to an “offline” state.
FAX/HOOK: Pressing this button selects fax send mode. This allows you to control the process whereby a 
document is scanned and then the scanned data is sent as a fax. If the button has been pressed twice and the 
external telephone handset is replaced, you can dial when you hear the dial tone.

4. RESET/LOG OUT:
Pressing this button returns all settings of a selected function to their default values, but does not stop any jobs 
that are already in progress.
At the top level screen, pressing this button logs the user out (if access control is enabled and active).

5. REDIAL/?HELP:
The last dialed telephone number is displayed. Pressing this button when the green LED on the 
START button is flashing, displays help information on the LCD screen.

6. Keypad
Use the numeric buttons to enter, for example, number of copies or a fax number. 
The * and # buttons are also used to navigate menus in touch-tone systems such as voice mail (if 
you have a telephone handset connected), or in vertical service codes. 
Refer to “Keypad - character switching” on page 16.

7. START:
> MONO - Pressing this button starts the copying, faxing or scanning process in black & white.
> COLOR - Pressing this button starts the copying or scanning process in color.
Green LED illuminates when copying/scanning is possible, if the LED is unlit then that function is not 
possible, e.g only the Mono button LED illuminates when faxing (color faxing is not possible).

8. STOP: Pressing this button stops the copying or scanning process.

9. BACK: Used to cancel selections and go back to the top level of the setting. The key is also used to 
cancel any previous input.

10. POWER SAVE: Pressing this button switches the power save mode on or off, its LED being 
illuminated when power save mode is on. If the machine has gone into power save mode as 
indicated by the screen being black and the LED being illuminated, you can return to normal mode 
by pressing the POWER SAVE button.

17
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KEYPAD - CHARACTER SWITCHING

Numbers, upper and lower case letters and symbols can be entered using the keypad. Press 
the key multiple times to switch between characters. 

The example below is based on English being the display language:

11. STATUS: Pressing this button gives access to the status menu screen. Use to check detailed status 
information about the machine. Flashes/illuminates if there is a status item to be displayed.

12. SETTING: Pressing this button gives access to several setup options on the LCD screen, including 
the administrator menu, profile options and address books settings.

13. CLEAR: Executes the following actions according to the entered items when pressed or held:
> Minimizes a setting value.
> Enters zero as a setting value.
> Clears what is entered.
> Cancels a selected item.

14. DATA IN MEMORY indicator light
LED illuminates to show data is stored in the MFP memory.

15. Arrow keys
Up: moves the cursor up.
Down: moves the cursor down.
Left: moves the cursor left. Can also be used to return to the previous screen.
Right: moves the cursor right. Can also be use to proceed to the next screen.

16. OK: Used to select and confirm current setting selections.

17. One-touch speed dial keys: Provides one-touch dialling of your most often used or favourite fax 
numbers or email addresses. Eight keys x two groups (press the SHIFT key to switch the groups).

NOTE
When pressing multiple times, you must re-press the key within 2 seconds of 
the previous press.

KEY AVAILABLE CHARACTER

1 1 -> 1

2 a -> b -> c -> 2 -> A -> B -> C

3 d -> e -> f -> 3 -> D -> E -> F

4 g -> h -> i -> 4 -> G -> H -> I

5 j -> k -> l -> 5 -> J -> K -> L

6 m -> n -> o -> 6 -> M -> N -> O

7 p -> q -> r -> s -> 7 -> P -> Q -> R -> S

8 t -> u -> v -> 8 -> T -> U -> V

9 w -> x -> y -> z -> 9 -> W -> X -> Y -> Z

0 SP (space) -> 0 -> SP (space)

* @ -> * -> @

# . -> _ -> - -> P -> SP (space) -> + -> ! -> “ -> $ -> % -> & -> ‘ -> ( 
-> ) -> , -> / -> : -> ; -> < -> = -> > -> ? -> [ -> £ -> ] -> ^ -> #

REF. DESCRIPTION
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CHANGING THE DISPLAY LANGUAGE

The default language used by your MFP for display messages and for report printing is 
English1. If required, this can be changed using the Panel Language Setup utility.

1. To ensure your product contains the latest firmware updates, it is recommended that you download 
the language files from this utility during setup.
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GETTING STARTED

TURNING ON YOUR MACHINE

1. Plug the AC cable into the AC power socket of your machine.

2. Plug the AC cable into the electric socket.

3. Check that no documents are on the document glass or ADF, and the ADF cover is 
closed.

4. Hold down the power switch for about a second to turn on the power.

The copy standby screen is displayed after your machine became ready status.

NOTE
Turn the power off, and when turning the power back on again, push the 
power switch after waiting for a few seconds.
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TURNING OFF YOUR MACHINE

Be sure to follow the procedure below every time you turn off the machine.

1. Hold down the power switch for about a second.

The message Shutdown in progress. Please wait. The machine turns off 
automatically. appears in the operator panel, and power switch indicator blinks 
every 1 second. Then the machine turns off automatically and power switch indicator 
goes out.

WHEN THE MACHINE IS NOT USED FOR LONG TIME

When the machine is not used for long time due to holidays or trips, pull the power cord 
from the socket.

NOTE
Press the power switch for less than 5 seconds.

NOTE
Turn the power off, and when turning the power back on again, push the 
power switch after waiting for a few seconds.

NOTE
The machine does not have functional failures if removing the power plug for 
long time (more than 4 weeks).
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POWER SAVING MODE

If you do not use the machine for a while, it will enter power saving mode to control the 
power consumption of the device. To cancel or initiate power saving mode, press the 
Power Save button on the control panel.

NOTE
If your machine is connected locally (via USB), when it transitions to Sleep 
mode its status is viewed as off-line. To use the printer in this state, you must 
press the Power Save button to exit sleep mode.

By default, the time interval to enter the power saving mode is set to 1 
minute.

You can enable or disable the power saving mode.
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SLEEP MODE

Your machine transitions from power saving mode to sleep mode after a set period of time. 
In sleep mode the power consumption of the device in minimal. To cancel sleep mode, 
press the Power Save button on the control panel.

NOTE
The machine will not enter sleep mode if an error occurs and the machine 
requires attention.

By default, the time interval to enter sleep mode is set to 30 minutes.

You can enable or disable sleep mode.

>  When the network connection is switched from wired to wireless, sleep 
mode is disabled. To enable sleep mode for devices connected using 
wireless LAN, enable sleep mode from the sleep mode setting menu.

>  When a device using the wireless LAN connection goes into sleep mode, the 
wireless LAN connection is broken. To reconnect to the wireless LAN, press 
the power save button on the device to recover from sleep mode.

>  After the device connected to the wireless LAN has recovered from sleep 
mode, it automatically connects to the wireless access point using the same 
settings as before it went into sleep mode. However, it may take up to 
1 minute to connect.

>  When the network connection is switched from wireless LAN to wired LAN, 
sleep mode is enabled.

>  Depending on your network environment, your device may wake from sleep 
mode immediately. If this happens, it is recommended that you disable 
sleep mode.
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AUTO POWER OFF

When your machine is not used for a certain period of time, it turns off the power 
automatically. Once the machine turns off the power, you need to turn on to use it.

The machine has three settings to select the machine's behavior on Auto Power Off. 

>  Enable

>  Auto Config

>  Disable

Enable: 

When your machine is not used for a certain period of time, it turns off the power 
automatically.

Auto Config:

The machine will not turn off the power automatically under the conditions listed below.

>  An Ethernet cable is plugged to network interface connection

>  A telephone cable is plugged to LINE connection 

Disable:

The Auto Power Off function is disabled. The machine will not turn off the power 
automatically.

By factory default, the time interval to turn off the power is set to 4 hours. You can change 
the time interval by pressing the SETTING key on the operator panel and then selecting 
Admin Setup > Manage Unit > Power Save > Auto Power Off Time.

By factory default, Auto Power Off is set to Auto Config or Disable. You can change the 
setting by pressing the SETTING key on the operator panel and then selecting Admin 
Setup > User Install > Power Setup > Auto Power Off.

NOTE
In the following cases, the Auto Power Off function is also disabled. 

>  When an error occurs

>  When time-set transmission is scheduled

>  When the fax transmission is waiting for a redial
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INSTALLING DRIVERS AND UTILITIES

The installation instructions below refer to USB connection. For network connection details 
refer to the Configuration Guide.

If you are running Windows Server 2008, Server 2008 R2 or Server 2012, you may need 
to follow these steps to ensure the WIA service starts when using the scanner driver and 
ActKey Utility:

1. Click Start > Administrative Tools > Services.

2. Double-click Services.

3. Double-click Windows Image Acquisition (WIA).

4. From the Startup type menu, select Automatic.

5. Under Service status, click Start.

6. Click OK.

NOTE
Example screenshots have been used throughout and may not represent your 
machine, however the procedure is the same.

NOTE
You must be logged on as an administrator or a member of the Administrators 
group in order to complete this procedure. If your computer is connected to a 
network, network policy settings may also prevent you from completing this 
procedure.

NOTE
In the case of Server 2008, Server 2008 R2, Server 2012 or Server 2012 R2,  
Desktop Experience needs to be installed.
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WINDOWS - SCANNER AND PRINTER DRIVERS

The scanner driver is used for “Pull Scan”, i.e. Initiating a scan from your PC via software. 
Compare this to “Push Scan” where you start the scan by pressing a button on the MFP's 
front panel.

1. Insert the DVD-ROM and click Install bunch to start the Oki driver installer 
program.

2. Follow the on-screen instructions to install the drivers.

3. Attach the printer to a USB port of your computer.

4. Switch on the printer.

NOTE
The Oki driver installer program is the recommended installation method.

NOTE
Do not connect the USB cable at this time. You will be instructed when to 
connect the USB cable when you run the Oki driver installer program.
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MAC - PRINTER DRIVER

The information in this section is based on Mac OS X 10.9. Other versions may appear 
slightly different, but the principles are the same.

1. Insert the DVD-ROM and run the Oki driver installer program.

2. Follow the on-screen instructions to install the printer driver.

3. Attach the printer to a USB port of your computer.

4. Switch on the printer.

5. Choose Apple Menu > System Preferences > Printers & Scanners.

6. If the printer is already in the list of printers, click “-” to remove it.

7. Click “+” to add a new printer.

8. Ensure:

> The Default tab is selected and select your machine from the list.

> Your machine is displayed as Kind “USB” in the list of available printers.

> The Use: selection matches your machine. 
If “AirPrint” is displayed, select a driver that matches.

9. Click Add.

10. Click Configure... and ensure the hardware options displayed match your machine.

11. The printer is added to the list of printers.

12. Restart your computer.

NOTE
This is necessary as Lion may not be using the correct Oki printer driver files.

NOTE
Hardware options are not configured automatically.
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FAX DRIVER

The fax driver allows you to send faxes directly from your computer without printing the 
document first.

With Oki's fax driver you are sending the fax data from your computer to the MFP, and then 
the MFP automatically sends the document.

Installing the fax driver
This is installed as part of the Oki driver installer wizard.

NOTE
Before using the internet fax function, you need to configure the server 
settings. Refer to the Configuration Guide for details.
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CONFIGURATION TOOL

Installation of the Configuration Tool is optional and can be found on the DVD in the Utilities 
folder. Follow the on-screen instructions to complete the Configuration Tool installation.

The Configuration Tool can discover devices over USB or network connections.

1. To search and install, select Tools > Register Device.

2. Highlight the required search result and when prompted click Yes.

The Configuration Tool allows you to set up and manage your MFP. Refer to the 
Configuration Guide for detailed instructions.

NOTE
Network settings, such as LDAP configuration, cannot be saved to the MFP 
from the Configuration Tool. For such settings, use the MFP operator panel or 
MFP web page.
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ACTKEY UTILITY 

The ActKey utility enables the MFP to receive one key touch commands from a connected 
computer.

Installation of the ActKey utility is optional and can be found on the DVD in the Utilities 
folder.

Information on using the ActKey utility can be found in “Remote Scan” on page 71.

Setting up the ActKey utility
1. Install the ActKey utility from the DVD:

Set-up will place an “ActKey” icon on your desktop.

2. Double-click this icon to open the ActKey console.

3. Select Options > Button Settings. The following screen displays.

4. Select the function you want to set in section (1).

5. Set the parameters for this function in section (2).

6. When you have completed settings, press OK (3).

The Utility will return to the ActKey console.

NOTE
The ActKey utility only supports Windows.

You must have the scanner driver installed.

3

2

1
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7. To use ActKey in Local PC mode (i.e. push scanning), it must be set as the program 
to handle scanner events:

(a) Click [Start] to select [Control Panel].

(b) Enter [View scanners and cameras] in [Search Control Panel].

(c) Click the [View scanners and cameras] under [Devices and Printers].

(d) Select [OKI Universal WIA] and click [Properties]. If the [User Account 
Control] dialog box appears, click [Yes].

(e) Click the [Events] tab.

(f) Select an event for [Select an event].

(g) Select the [Start this program] check box and then select [ActKey].

(h) Repeat steps (f) and (g) so that [ActKey] is set to all events.

(i) Click [OK].
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PAPER RECOMMENDATIONS
Your MFP will handle a variety of print media, including a range of paper weights and sizes. 
This section provides general advice on choice of media, and explains how to use each type.

The best performance will be obtained when using standard 75~90g/m² paper designed 
for use in copiers and laser printers.

Use of heavily embossed or very rough textured paper is not recommended.

Pre-printed stationery can be used, but the ink must not offset when exposed to the high 
fuser temperatures used in the printing process.

Envelopes

Labels

CAUTION!

Envelopes should be free from twist, curl or other deformations. 
They should also be of the rectangular flap type, with glue that 
remains intact when subjected to hot roll pressure fusing used in 
this type of printer. Window envelopes are not suitable.

CAUTION!

Labels should also be of the type recommended for use in copiers 
and laser printers, in which the base carrier page is entirely 
covered by labels. Other types of label stock may damage the 
printer due to the labels peeling off during the printing process.
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CASSETTE TRAYS

If you have identical paper stock loaded in another tray (2nd tray if you have one, or multi 
purpose tray) you have the printer automatically switch to the other tray when the current 
tray runs out of paper. When printing from Windows applications, this function is enabled 
in the driver settings. When printing from other systems, this function is enabled in the 
Print Menu.

SIZE DIMENSIONS WEIGHT (G/M²)

A6a

a. this paper size can be printed from Tray1 or MP Tray only.

b. this paper size can be printed from the MP Tray only.

105 x 148mm Light 64 - 74g/m²
Medium Light 75 - 82g/m²
Medium 83 - 104g/m²
Heavy 105 - 120g/m²
Ultra heavy1 121 - 176g/m²
Ultra heavy2 177 - 220g/m²
Tray 1/2: 64 - 176g/m²

MP Tray: 64 - 220g/m²
Duplex: 64 - 176g/m²

A5 148 x 210mm
B5 182 x 257mm
16K (184x260mm) 184 x 260mm
Executive 184.2 x 266.7mm
16K (195x270mm) 195 x 270mm
16K (197x273mm) 197 x 273mm
A4 210 x 297mm
Letter 215.9 x 279.4mm
Legal 13in. 215.9 x 330.2mm
Legal 13.5in. 215.9 x 342.9mm
Legal 14in. 215.9 x 355.6mm
Custom

COM-9 Envelopeb 98.4 x 225.4mm

COM-10 Envelopeb 104.8 x 241.3mm

Monarch Envelopeb 98.4 x 190.5mm

DL Envelopeb 110 x 220mm

C5 Envelopeb 162 x 229mm

Hagakia 100 x 148mm

Oufukuhagakib 148 x 200mm

Nagagata #3b 120 x 235mm

Nagagata #4b 90 x 205mm

Yougata #4b 105 x 235mm

Futo A4b 210 x 297mm

Index Cardb 76.2 x 127mm
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MULTI PURPOSE TRAY

The multi purpose tray can handle the same sizes as the cassette trays but in weights up 
to 220g/m². For very heavy paper stock use the rear output tray. This ensures that the 
paper path through the printer is almost straight.

The multi purpose tray can feed paper widths from 76mm to 215.9mm and lengths from 
127.0mm to 1320mm (banner printing).

For paper lengths exceeding 356mm (Legal 14in.) use paper stock between 90g/m² and 
128g/m² and the rear output tray.

Use the multi purpose tray for printing on envelopes. Up to 10 envelopes can be loaded at 
one time, subject to a maximum stacking depth of 10mm.

OUTPUT TRAY

The output tray on the top of the printer can hold up to 150 sheets of 80g/m² standard 
paper, and can handle paper stocks up to 176g/m².

Pages printed in reading order (page 1 first) will be sorted in reading order (last page on 
top, facing down).

REAR OUTPUT TRAY

The rear output tray at the rear of the printer should be opened and the tray extension 
pulled out when required for use. In this condition paper will exit via this path, regardless 
of driver settings.

The rear output tray can hold up to 100 sheets of 80g/m² standard paper, and can handle 
stocks up to 220g/m².

Always use this rear output tray and the multi purpose feeder for paper stocks heavier than 
176g/m².

DUPLEX

Automatic two-sided printing on the same range of paper sizes as tray 2 (i.e. all cassette 
sizes except A6), using paper stocks from 64 - 176g/m².

NOTE
The rear output tray cannot be used when printing duplex.
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LOADING PAPER

CASSETTE TRAYS

1. Remove the paper tray from the machine.

2. Fan the paper to be loaded at the edges (1) and in the middle (2) to ensure that all 
sheets are properly separated, then tap the edges of the stack on a flat surface to 
make it flush again (3).

1
2

3
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3. Load paper (letter headed paper face down and top edge towards the front of the 
printer), as shown.

4. Adjust the rear stopper (a) and paper guides (b) to the size of paper being used.

5. Close the paper tray gently.

6. Set the correct paper size. Refer to “Configuring the tray settings” on page 36 and 
“Registering custom sizes” on page 37.

To prevent paper jams:

> Do not leave space between the paper and the guides and rear stopper.

> Do not overfill the paper tray. Capacity depends on the type of paper stock.

> Do not load damaged paper.

> Do not load paper of different sizes or types at the same time.

> Close the paper tray gently.

NOTE
After closing the tray, the media selection screen will be displayed on the 
panel.

a

b
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> Do not pull the paper tray out during printing (except as described below for the 2nd 
tray).

NOTE
> If you have two trays and you are printing from the 1st (upper) tray, you 

can pull out the 2nd (lower) tray during printing to reload it. However, if 
you are printing from the 2nd (lower) tray, do not pull out the 1st (upper) 
tray. This will cause a paper jam.

> For face down printing, make sure the rear output tray (a) is closed (the 
paper exits from the top of the printer). Stacking capacity is 
approximately 150 sheets, depending on paper weight.

> For face up printing, make sure the rear output tray (a) is open and the 
paper support (b) is extended. Paper is stacked in reverse order and tray 
capacity is approximately 100 sheets, depending on paper weight.

> Always use the rear output tray for heavy paper (card stock, etc.).

CAUTION!

Do not open or close the rear paper exit while printing as it may 
result in a paper jam.

b

a
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MULTI PURPOSE TRAY

1. Open the multi purpose tray (a).

2. Fold out the paper supports (b).

3. Press gently down on the paper platform (c) to ensure it is latched down.

4. Load the paper and adjust the paper guides (d) to the size of paper being used.

> For single-sided printing on headed paper load the paper into the multi purpose 
tray with pre-printed side up and top edge into the printer.

> For two-sided (duplex) printing on headed paper load the paper with pre-printed 
side down and top edge away from the printer.

> Envelopes should be loaded face up with top edge to the left and short edge into 
the printer. Do not select duplex printing on envelopes.

> Do not exceed the paper capacity of about 100 sheets or 10 envelopes. Maximum 
stacking depth is 10mm.

5. Press the tray latch button inwards to release the paper platform, so that the paper 
is lifted and gripped in place.

6. Set the correct paper size. Refer to “Configuring the tray settings” on page 36 and 
“Registering custom sizes” on page 37.

CONFIGURING THE TRAY SETTINGS

After you load paper in tray 1, tray 2 (optional), or the MP tray, you need to register the 
loaded paper on your machine.

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Paper Setup and press OK.

3. Using the arrow keys, scroll to the required paper tray and press OK.

4. Press OK to select Paper Size.

5. Using the arrow keys, scroll to the loaded paper size and press OK.

6. Using the Down arrow key, scroll to Media Type and press OK.

7. Using the arrow keys, scroll to the type of media loaded and press OK.

8. Using the Down arrow key, scroll to Media Weight and press OK.

9. Using the arrow keys, scroll to the weight of the loaded paper and press OK.

10. Press the Left arrow key to exit the menu.

b

d

d
c

a
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REGISTERING CUSTOM SIZES

To load custom size paper, you need to register the width and length of the paper before 
printing.

The range of the sizes you can set differs according to the paper tray.

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Paper Setup and press OK.

3. Using the arrow keys, scroll to the required paper tray and press OK.

4. Using the Down arrow key, scroll to Custom and press OK.

5. Using the keypad, enter the Width and Length of the loaded paper.

Press the Right arrow key to move between digits.

6. Press OK.

7. Press the Left arrow key to exit the menu.

TRAY AVAILABLE SIZE RANGE

Tray 1 Width: 105 to 216 mm (4.1 to 8.5 inches)
Length: 148 to 356 mm (5.8 to 14.0 inches)

Tray 2 (optional) Width: 148 to 216 mm (5.8 to 8.5 inches)
Length: 210 to 356 mm (8.3 to 14.0 inches)

MP tray Width: 64 to 216 mm (2.5 to 8.5 inches)
Length: 127 to 1321 mm (5.0 to 52.0 inches)

NOTE
For tray 1 and tray 2, you can configure the Custom setting only when Paper 
Size is set to Custom.

The available size range for duplex printing is the same as that for tray 2.
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USER AUTHENTICATION AND ACCESS CONTROL
If your Administrator has enabled access control on your machine, it will automatically start 
up in access control mode. You will not be able to use it until you have provided valid login 
information. If the access control setting is:

> PIN; you will need to provide a valid PIN (personal identification number).

> User name and password; you will need to provide a valid user name and 
password.

After using it, you will be expected to log out, leaving the machine in access control mode, 
unable to be used by unauthorised users.

PIN AUTHENTICATION

LOGGING INTO THE MACHINE

1. Enter your PIN using the keypad on the control panel.

2. Press OK.

If authentication succeeds, the top screen displays.

LOGGING OUT OF THE MACHINE

When you have finished operations, be sure to log out of the machine.

1. Press the BACK button or Left arrow key until the top screen displays.

2. Press the RESET/LOGOUT button on the control panel.

USER NAME AND PASSWORD AUTHENTICATION

LOGGING INTO THE MACHINE

1. Make sure that User Name is selected and then press the Right arrow key.

2. Enter your name.

3. Using the arrow keys, highlight Done and then press OK.

4. Make sure that Password is selected and then press OK.

5. Enter your password.

6. Using the arrow keys, highlight Done and then press OK.

7. At the Login screen, press OK.

If authentication succeeds, the top screen displays.

LOGGING OUT OF THE MACHINE

When you have finished operations, be sure to log out of the machine.

1. Press the BACK button or Left arrow key until the top screen displays.

2. Press the RESET/LOGOUT button on the control panel.

NOTE
After a certain period of time, the machine automatically logs out users.

NOTE
After a certain period of time, the machine automatically logs out users.
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OPERATION FROM THE COMPUTER

Printing from Windows

1. Open the file you want to print.

2. From the File menu, select Print.

3. Choose the printer driver you want in Select Printer and click Preferences.

4. Select the Job Options tab.

5. Click User Auth....

6. Select the Use User Authentication check box.

7. Enter the user name in Username and the password in Password.

Clicking Use Windows Login automatically enters your login name on Windows.

8. Click OK.

9. Click OK and then click Print.

Printing from Mac

1. Open the file you want to print.

2. From the File menu, select Print.

3. Select your machine’s printer driver.

4. Select User Auth... from the panel menu under the Printer and Presets menus.

5. Select the Use User Authentication check box.

6. Enter the user name in User Name and the password in Password.

7. Click Print.

NOTE
The authentication type specified on the computer overrides the one specified 
on the machine.

NOTE
You cannot use the XPS printer driver for this function.

This procedure uses Windows 7 and NotePad as an example. The procedures 
and menus may differ depending on the OS you use.

NOTE
This procedure uses Mac OS X 10.9 as an example. The procedures and menus 
may differ depending on the OS you use.
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Faxing (Windows only)

1. Open the file you want to fax.

2. From the File menu, select Print.

3. Select your machine (fax driver) in Select Printer and click Preferences.

4. On the Setup tab, click User Authentication....

5. Select the Use User Authentication check box.

6. Enter the user name in Username and the password in Password.

Clicking Use Windows Login automatically enters your login name on Windows.

7. Click OK.

8. Click OK and then click Print.

NOTE
This procedure uses Windows 7 and NotePad as an example. The procedures 
and menus may differ depending on the OS you use.
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OPERATION
With its intuitive control panel, this Multi Function Product (MFP) is designed to be easy to 
use. After the machine has been configured, operating is quite straight forward.

The following sections describe how to copy, fax, and scan your documents.

Refer to “Printing” on page 83 for details of how to use the printing options available from 
the control panel. For full details of how to use your machine and any optional accessories 
to print jobs efficiently and effectively, please refer to the Printing Guide and the Barcode 
Printing Guide.

For full details of how to access and use the security features, please refer to the Security 
Guide.

NOTE
If your Administrator has enabled access control on your machine, it will 
automatically start up in access control mode. You will not be able to use it 
until you have provided valid login information. Refer to “User authentication 
and access control” on page 38 for details.
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MULTI-TASKING

Your machine can handle more than one task at a time. The table below details which 
combination of tasks can be performed.

   1st

2
n
d

Copy Scan to 
email/

network 
PC

Internet 
Fax (Tx)

Scan to 
USB 

memory

Fax 
Tx

Fax 
Rx

Print 
from 
USB 

(direct 
print)

PC scan 
(remote 

PC)

Email to 
print

Internet 
Fax (Rx)

Print

Print 
from 
Web 

(direct 
print)

Copy Yesf Yes Yes No Yesa

a. Data is accepted but printing is halted until the 1st action is complete.

Yesb

b. While only printing the first print action (scan is completed), the second action can be allowed to browse the 
files on the USB memory.

Yes Yesa Yesa

Scan to 
email/
network 
PC

Internet 
Fax (Tx)

Yes Yes Yes No Yes Yes Yes Yes Yes

Scan to 
USB 
memory

No No No No Yes No No Yes Yes

Fax Tx Yes Yes Yes Yesc

c. Operation is accepted but operation is halted until the 1st action is complete.

No Yes Yes Yes Yes

Fax Rx Nod

d. Copy is enabled only before the start of printing of a received fax image.

Yes Yes Yesc No Yesb Yes Yesa Yesa

Print 
from USB 
(direct 
print)

Yesg Yes Yes Yes Yesa Yesb Yes Noe

e. The second action won't be able to do due to less available memory.

f.   The second scan action is enabled after the first one has completed. The second print action is enabled after 
the first one has completed.

g.  The second print action is enabled after the first one has completed.

Yesa

PC scan 
(remote 
PC)

No No No No Yes No No Yes Yes

Email to 
print

Internet 
Fax (Rx)

Yesg Yes Yes Yes Yes Yesb Yes Noe Yesa

Print

Print 
from Web 
(direct 
print)

Yesg Yes Yes Yes Yesa Yesb Yes Yesa Yesa
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LOADING DOCUMENT(S)
The MFP can scan/copy/send document(s) either from the ADF (Automatic Document 
Feeder) or on the glass. If you need to send multiple pages, load your papers in the ADF. 
The ADF can hold up to 50 pages at one time.

If you need to scan/copy/send pages from books, newspaper clippings, or paper with 
wrinkles or curls, place them on the glass.

DOCUMENT REQUIREMENTS

Before using the ADF, please make sure that your paper meets the following specifications:

> Document(s) can range in size from 114.3 x 139.7mm to 215.9 x 355.6mm.

> Document(s) can range in weight from 60 to 120 g/m².

> Document(s) should be square or rectangular and in good condition (not fragile or 
worn).

> Document(s) should be free of curl, wrinkle, tears, wet ink, or punch holes.

> Document(s) should be free of staples, paper clips, paper sticky notes.

> Keep the glass clean and without any documents left on it.

SCANNABLE AREA

Text or images within the shaded area are not scanned.

NOTE
To transmit irregular types of document(s), place the document(s) on the 
glass or make a copy first and then transmit the copy instead.

When faxing, you can load only A4, letter, or legal size documents in the ADF, 
and A4 or letter size documents on the document glass. You cannot load mixed 
size documents.
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PLACING DOCUMENT(S) IN THE ADF
1. If you have multiple pages, fan the pages to avoid paper jams. The ADF holds up to 

50 pages at one time.

2. Place the document with the text face UP in the ADF:

> If your document is portrait, load with the top edge of the document in first.

> If your document is landscape, load with the left edge of the document in first.

3. Adjust the Paper Guides to centre the document in the ADF.

b

a

c
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PLACING DOCUMENT(S) ON THE GLASS

1. Open the document cover.

2. Place your document with the text face DOWN on the glass:

> If your document is portrait, align its top edge to the upper-left corner of the 
glass.

> If your document is landscape, align its right edge to the upper-left corner of the 
glass.

3. Close the document cover.
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COPYING

BASIC OPERATION

1. Place your document(s) with text face UP in the ADF or face DOWN on the glass.

2. If required, press the Copy button (1) on the control panel to prompt the Copy 
screen.

3. Press Mono (2) to copy your document(s) in black and white, or Color(3) to copy 
your document(s) in color.

INCREASING COPY COUNT

The machine is preset to a copy count of 1. If you wish to increase the number of copies, 
select the number of copies with the numeric keypad.

To increase the copy count:

1. If required, press the Copy button on the control panel to prompt the Copy screen.

2. Enter number of copies required using the numeric keypad. The screen display will 
confirm the copy count selected.

NOTE
If your Administrator has enabled access control on your machine, it will 
automatically start up in access control mode. You will not be able to use it 
until you have provided valid login information. Refer to “User authentication 
and access control” on page 38 for details.

NOTE
Factory default setting is Copy mode.

NOTE
If you wish to cancel the copy process, press Stop (4) to abort the operation.

NOTE
You can select up to 99 copies.

2 3 4

1
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ADVANCED OPERATION

Using the options available you can alter the copy output to suit your needs:

1. Press the Right arrow key.

2. Select required parameter with Down arrow key and press the OK button or the 
Right arrow key to display the available options.

3. Using Up or Down arrow keys, select value and press OK.

Options are (factory default settings in bold text):

FEATURE OPTION DESCRIPTION

Scan Size A4, A5, A6, B5, B6, Letter, Legal 13, Legal 13.5, 
Legal 14, Executive, Statement, 8.5SQ, Folio

Allows you to select the document 
size.

Duplex Copy OFF(Simplex), Simplex -> Duplex LE, 
Simplex -> Duplex SE, Duplex -> Duplex, 
Duplex LE -> Simplex, Duplex SE -> Simplex

Turns the duplex (2-sided) function 
off or on.
Note: A6 duplex scan is not 
supported.

Binding Long Edge Bind, Short Edge Bind Sets the default binding to LEF or SEF. 
Display condition: Duplex Copy is set 
to Duplex -> Duplex and N-up or 
Repeat is ON.

Paper Feed Auto, Tray 1(A4), Tray 2(A4)*, MP Tray(A4) Allows you to define the paper tray for 
printing.
Auto - Allows for automatic tray 
selection based on the document 
image size and/or scaling setting 
defined.
* If fitted.

Zoom Auto, 100%, Zoom (25-400%), A4->A5(70%), 
Leg14->Let(78%), Leg13.5->Let(81%), 
Leg13->Let(84%), A4->B5(86%), 
A4->Let(94%), Let->A4(97%), 
Fit to page(98%), B5->A4(115%), 
A5->B5(122%), A5->A4(141%)

Allows you to scale the copy using the 
presets values or by scaling in 1% 
increments up to 400% and down to 0 
by entering the value using the 
keypad.

Sort ON, OFF ON prints 1 entire copy/set of the 
multiple copy document at a time 
(e.g. pages 1,2,3,1,2,3,1,2,3,…) 
OFF batch prints the multiple copy 
document page by page (e.g. pages 
1,1,1,2,2,2,3,3,3,…)
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Image 
Settings

Density -3, -2, -1, 0, +1, 
+2, +3

Adjust density
Darker: Keep color intensity and 
darker image.
Lighter: Reduce color intensity and 
gives lighter image.

Document Type Text, Text&Photo, 
Photo, Photo 
(Glossy)

Allows you to specify the type of 
images on the document.

Resolution For Color Normal, Extra Fine Allows you to select the scanning 
resolution. The Extra Fine setting 
reproduces a higher resolution image 
with greater detail, however this 
requires more disk space.
Note: In Mono copy mode, the 
resolution is fixed to Extra Fine.

Background Removal Auto, OFF, 1, 2, 3, 
4, 5, 6

Allows you to block out the color 
background of the image (assuming 
document has a color background) - 
such that the background color is not 
printed.

Show-Through Removal OFF, Low, Middle, 
High 

Adjusts the level of show-through 
removal.
Note: It is available only when 
“Background Removal” is set to “Auto” 
and “Document Type” is “Text” or 
“Text&Photo”.

Contrast -3, -2, -1, 0, +1, 
+2, +3

Contrast setting
High: Enhance brightness
Low: Reduce brightness

Hue -3, -2, -1, 0, +1, 
+2, +3

Red/green balance adjustment.
Low: Enhance red.
High: Enhance green.

Saturation -3, -2, -1, 0, +1, 
+2, +3

Saturation setting
High: Enhance image sharpness
Low: Reduce hue

RGB Red: -3, -2, -1, 0, 
+1, +2, +3
Green: -3, -2, -1, 0, 
+1, +2, +3
Blue: -3, -2, -1, 0, 
+1, +2, +3

Adjust RGB contrast settings. Use the 
arrow keys to increment and 
decrement the values and to move to 
the next color setting.

Direction Portrait, Landscape Selects the default page orientation.

N-In-1 OFF 
2-in-1 
4-in-1: Vertical 
4-in-1: Horizontal

Allows you to print multiple pages of 
the document to a single sheet of 
paper.
2-n-1 layout orientation and image 
order is fixed. If you specify 4-in-1 
you can specify horizontal or vertical 
orientation. If you specify 2-in-1 or 4-
in-1, set your original documents on 
the ADF, alternatively enable 
Continuous Scan mode and use the 
document glass (see “Continuous 
Scan” on page 49).

FEATURE OPTION DESCRIPTION
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4. Press the Left arrow key or Back button to return to the start menu.

5. If access control is enabled, logout once you are finished to avoid any unauthorised 
access.

RESETTING COPY SETTINGS

AUTO RESET

All settings you configured for your copy job return to their default values if no operation 
is made for a set period of time. 

The factory default setting is 3 minutes.

USING THE RESET/LOGOUT BUTTON

By pressing the RESET/LOGOUT button, the settings you configured for your copy job 
return to their default values.

After copying, press the RESET/LOGOUT key to reset the default settings for the next 
user.

Repeat OFF 
x2 
x4

Allows you to print multiple images of 
an original document on a single 
sheet.

ID Card Copy ON, OFF Allows you to set ID card copying as 
the default copy mode.

Continuous 
Scan

ON, OFF Allows you to continue scanning more 
documents. Allows you to construct a 
single scan job from multiple 
individual sheets or originals.

Mixed Size ON, OFF Allows you to load originals of same 
width but different length in the ADF.
The following document sizes can be 
set concurrently; A3 and A4 LEF, B4 
and B5 LEF, A4SEF and A5 LEF.
When enabled, the tray setting is 
automatic, you cannot specify a tray 
manually.

Margin ON, OFF Allows you to change the document 
top and left margin areas. 
Input range: -25 to +25mm.

Edge Erase ON, OFF Allows you to block out the peripheral 
areas of the document where spurious 
shadows and borders may arise when 
copying with the document cover 
open (such as with books and 
magazines) or for other purposes. 
Input range: 2 to 50mm.

FEATURE OPTION DESCRIPTION
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SCANNING

INSTALLING SCANNER DRIVERS (TWAIN/WIA/ICA DRIVER)
This section explains the procedure to install the scanner driver. Before using scan function, 
install the scanner driver. You can install TWAIN driver and WIA (Windows only) driver at the 
same time. Install the TWAIN driver and ICA driver (dedicate to the Mac OS X) separately.

If you want to use the network scan function, follow the installation procedure below and 
register the information of your computer and then install the scanner driver.

INSTALLATION PROCEDURE

For Windows
1. Ensure that your machine and the computer are turned on and connected, and then 

insert the “Software DVD-ROM” into the computer.

2. Click Run setup.exe after Auto Play is displayed. 
If the User Account Control dialog box appears, click Yes.

3. Select the language and then click Next.

4. Select the device of your machine, and then click Next.

5. Read the license agreement and then click I Agree.

6. Select the proper driver under Software, and then click the install icon.

7. Click Next, and then click Custom Installation.

MEMO
When using the network scan function in Windows, please install the ActKey 
utility.

REFERENCE
Before installing the scanner driver manual, do the network settings.For 
details on how to do network settings, refer to the Configuration Guide.

NOTE
When using a scanner with a network connection in Windows, if the equipment 
IP address is changed, please change the settings in Network Configuration. 
For Mac OS X, please change settings in network scanner setting tools. For 
details, refer to Configuration Guide.

MEMO
When using the network scan function in Windows, please install the Network 
Configuration. For Mac OS X, the network scanner setting tools will be installed 
automatically.
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If the scanner driver has been installed, the setup maintenance program of the 
scanner driver is displayed. Check the checkbox of Add and then click Next to 
proceed to the step 8.

8. Click Next.

9. Check the checkbox of Network scanner and click Next.

10. Select IP Address or Search MFP check box to enter the address of the machine 
and then click Next. 

If you want to set the IP Address, follow procedure 10.
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11. If Search MFP is selected, select the machine and click Next.

12. Set the scanner driver name and click Next.

13. Enter the host name, IP address and port number and then click Configure.

14. Click Next.

15. Click Next.
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16. Click Finish.

For Mac OS X
1. Make sure that the machine is connected to the PC and the power switch of the 

machine is turned ON. Then, load the “Software DVD-ROM” on the drive of the PC.

2. Double-click the OKI icon on the desktop.

3. Double-click Drivers > Scanner > Installer for OS X 10.8.

4. Click Continue.

5. Click Continue.

6. Check the display and click Continue if OK.
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7. Read the license agreement and click Continue.

8. Click Agree if you agree.

9. Click Install.

To change the installation location of the driver, click Change Install Location.

10. Enter the administrator's name and password, and click OK.

11. Click Continue Installation.

12. Click Restart.
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USING ACTKEY SOFTWARE

Using the ActKey, you can start a scan job in specified settings with a click a button.

Installing the Software
1. Insert the “Software DVD-ROM” into your computer.

A window opens.

2. Select ActKey from Software.

3. Install the software as instructed.

4. Click Finish.

Starting the Software
1. Click Start to select All Programs > Okidata > ActKey > ActKey.

MEMO
ActKey does not support Mac OS X.

Using WSD Scanning, Actkey does not work.

When ActKey is installed, Network Configuration is also installed 
simultaneously.

REFERENCE
For details on how to start a scan job, refer to the Configuration Guide.
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SETUP TO USE THE WSD SCAN

The following explains how to set up the PC to use the WSD Scan function. In order to use 
the WSD Scan function, install this device on the PC.

WSD Scan can be used from Scan To Computer and Remote Scan via Network.

To use WSD Scan, the machine has to be connected with the computer which Windows 
Vista/ Windows7/ Windows8/ Windows10/ Windows Server 2008/ Windows Server 
2008R2/ Windows Server 2012/ Windows Server 2012 R2 was installed via Network.

INSTALLATION PROCEDURE

1. From the Start menu, select Network. The devices connected to the network are 
displayed.

2. Right-click the MC363 icon under Multifunction Devices and select Install.

If the User Account Control dialog box is displayed, click Yes.

REFERENCE
Before starting the following procedure, be sure to check the network 
connection. For details, see the Configuration Guide.

NOTE
If a scanner is used via WSD Scan connection and if the device IP address is 
changed, select Uninstall in step 2 of Installation procedure and uninstall the 
scanner, and then execute the install procedure again.

MEMO
When you follow the procedure below, the WIA is installed automatically as 
the scanner driver.

NOTE
Before starting the installation, select Network and Sharing Center from 
the Control Panel and make sure that Network Search is enabled.



Scanning > 57

3. When the balloon message saying that the installation is complete is displayed on 
the task bar, click the balloon to check the details, and click Close.

Check the device installation on the machine as follows.

4. Press the SCAN key on the operator panel.

5. Press the  to select Computer and then press OK.

6. Check that Select A Connecting PC is selected, and press OK.

7. Press the  to select From WSD Scan, and press OK.

8. Make sure that the device installation PC is displayed as the destination PC.

SCANNING METHODS

1. Place your document(s) with text face UP in the ADF or face DOWN on the glass.

2. Press the Scan button (1) on the control panel to prompt the Scan Menu screen.

3. Select the scan destination from the following options:

> E-mail

> Computer

MEMO
A maximum of 50 PCs can be registered.

NOTE
If your Administrator has enabled access control on your machine, it will 
automatically start up in access control mode. You will not be able to use it 
until you have provided valid login information. Refer to “User authentication 
and access control” on page 38 for details.

2 3 4

1
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> USB Memory

> Shared Folder

> Remote Scan

4. Set your scanning options as required. For further details refer to the following 
sections.

5. Press Mono (2) to scan your document(s) in black and white, or Color (3) to scan 
your document(s) in color.

NOTE
Computer; select target application from the control panel on the MFP.

Remote Scan; select target application from utility on your PC.

“Remote Scan” is not shown when PC Scan Mode is in Simple Scan Mode.

NOTE
If you wish to cancel the scan process, press Stop (4) to abort the operation.
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SCAN TO E-MAIL

Using the options available, you can enter E-mail information and alter the scan output to 
suit your needs:

1. Place your document(s) with text face UP in the ADF or face DOWN on the glass.

2. Press the Scan button on the control panel to prompt the Scan Menu screen.

3. If required, use the arrow keys and scroll to E-mail, then press OK.

4. Using the options available, you can enter E-mail destination(s) and alter the scan 
output to suit your needs. 

NOTE
For illustration purposes only, the features shown are as accessed from the 
control panel.

FEATURE OPTION DESCRIPTION

Destination To Operation 
Menu

Edit Destination 
Type

Delete The Address

Close The List

Cc Operation 
Menu

Edit Destination 
Type

Delete The Address

Close The List

Bcc Operation 
Menu

Edit Destination 
Type

Delete The Address

Close The List

Add Destination To:
Cc:

Bcc:

Address Book Select E-mail address from 
the address book.
Input range: 001-300

Group List Select destination group 
from the list.
Input range: 01-20

Tx History Displays the list of sent 
E-mails.
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Add Destination
(cont.)

To:
Cc:

Bcc:
(cont.)

Direct Input Enter E-mail address using 
the on-screen keyboard.

LDAP Simple Search Use the on-screen keyboard 
to enter a search value.

Advanced Search
Search Method:

User Name:
E-mail Address:

Use Advanced Search to 
search the LDAP address 
book by user name and/or 
E-mail address.
Can display up to 100 
addresses.

Scan Settings Scan Size A4, A5, A6, B5, B6, Letter, Legal 13, 
Legal 13.5, Legal 14, Executive, 
Statement, 8.5SQ, Folio

Allows you to select the scan 
size.

Duplex Scan OFF, Long Edge Bind, Short Edge 
Bind

Select the bound originals 
binding position.
Note: A6 duplex scan is not 
supported.

Image Settings Density -3, -2, -1, 0, +1, 
+2, +3

Adjust density
Darker: Keep color intensity 
and darker image.
Lighter: Reduce color intensity 
and gives lighter image.

Document 
Type

Text, Text&Photo, 
Photo, Photo 
(Glossy)

Allows you to specify the 
type of images on the 
document.

Resolution 75dpi, 100dpi, 
150dpi, 200dpi, 
300dpi, 400dpi, 
600dpi

Allows you to select the 
appropriate resolution.
Remember the higher the 
resolution the bigger the file size!

Background 
Removal

Auto, OFF, 1, 2, 3, 
4, 5, 6

Allows you to block out any 
unintended background color.

Show-
Through 
Removal

OFF, Low, Middle, 
High

Adjusts the level of show-
through removal.
Note: It is available only 
when “Background Removal” 
is set to “Auto” and 
“Document Type” is “Text” or 
“Text&Photo”.

Contrast -3, -2, -1, 0, +1, 
+2, +3

Contrast setting
High: Enhance brightness
Low: Reduce brightness

Hue -3, -2, -1, 0, +1, 
+2, +3

Red/green balance adjustment.
Low: Enhance red.
High: Enhance green.

Saturation -3, -2, -1, 0, +1, 
+2, +3

Saturation setting
High: Enhance image 
sharpness
Low: Reduce hue

RGB Red: -3, -2, -1, 0, 
+1, +2, +3
Green: -3, -2, -1, 
0, +1, +2, +3
Blue: -3, -2, -1, 0, 
+1, +2, +3

Adjust RGB contrast settings. 
Use the arrow keys to 
increment and decrement 
the values and to move to 
the next color setting.

Reply To Address Book Select E-mail address from 
the address book.
Input range: 001-300

FEATURE OPTION DESCRIPTION
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Scan Settings
(cont.)

Reply To
(cont.)

Direct Input Enter E-mail address using 
the on-screen keyboard.

LDAP Simple Search Use the on-screen keyboard 
to enter a search value.

Advanced Search
Search Method:

User Name:
E-mail Address:

Use Advanced Search to 
search the LDAP address 
book by user name and/or 
E-mail address.
Can display up to 100 
addresses.

Edit E-mail Subject Select Subject Enter new or edit the default 
E-mail subject and text 
templates.
For further details refer to 
“Creating E-mail templates” 
on page 79.

Direct Input

E-mail Body Select Text

Direct Input

File Name User defined Use the on-screen keyboard 
to enter an appropriate file 
name.

Continuous 
Scan

ON, OFF Allows you to continue 
scanning more documents. 
Allows you to construct a 
single scan job from multiple 
individual sheets or originals. 
Refer to “Continuous scan 
mode” on page 109 for 
details.

Grayscale ON, OFF Select ON to print in 
grayscale.

File Format Color:
Single-PDF, Multi-PDF, Single-HC-
PDF, Multi-HC-PDF, Multi-PDF/A, 
Single-TIFF, Multi-TIFF, JPEG, XPS
Mono (Grayscale):
Single-PDF, Multi-PDF, Single-HC-
PDF, Multi-HC-PDF, Multi-PDF/A, 
Single-TIFF, Multi-TIFF, JPEG, XPS
Mono (Binary):
Single-PDF, Multi-PDF, Multi-PDF/A, 
Single-TIFF, Multi-TIFF, XPS

Select the appropriate file 
format.

Encrypted PDF Not Encrypt
Encrypt Low, Medium, High

Select the appropriate 
encryption level.

Compression 
Rate/Color, 
Grayscale

High, Medium, Low Select the appropriate 
compression level.

Edge Erase ON, OFF Use the keypad to enter the 
width settings.
Input range: 5 to 50mm

Tx History Displays the list of sent 
E-mails.

FEATURE OPTION DESCRIPTION
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5. Press the Mono button to scan your document(s) in black and white, or the 
Color button to scan your document(s) in color.

On completion the machine will beep and a confirmation message displays.

6. If access control is enabled, logout once you are finished to avoid any unauthorised 
access.

NOTE
> If you want to use the address book or group list features, be sure to 

register the E-mail addresses in advance. Refer to “Managing the address 
book” on page 78.

> This machine allows you to send scanned document(s) to multiple E-mail 
addresses. Simply select the destination you require and press OK, then 
repeat until all the destinations you require are selected.

> Up to 48 characters can be entered in the “Destination”, “Reply to” and 
the “Subject” fields.

> If the administrator has set SMTP or POP3 authentication, after sending 
your scanned document to E-mail addresses, and if no more transmission 
is required, log out of the system. This is to prevent misuse of the user's 
E-mail account for sending E-mails. If there is no other operation within 
3 minutes, the system will log out automatically.

NOTE
If you wish to cancel the scan process, press the Stop button to abort the 
operation.

NOTE
MDN (message disposition notification) and DSN (delivery status notification) 
can enabled/disabled by the administrator.
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SCAN TO SHARED FOLDER

Before sending your document to a file server, profiles should be set up first to speed up 
the process. A profile contains a list of filing parameters such as your filing protocol, 
directory, file name and other scanning parameters.

1. Place your document(s) with text face UP in the ADF or face DOWN on the glass.

2. Press the Scan button on the control panel to prompt the Scan Menu screen.

3. Using the Down arrow key, scroll to Shared Folder and press OK.

4. Using the Down arrow key, scroll to Select Profile and press OK.

The list of registered profiles displays.

5. Using the Down arrow key, scroll to the required profile and press OK.

6. Using the Down arrow key, scroll to Scan Setting and press OK.

Using the options available, you can enter network information and alter the scan out 
put to suit your needs. 

NOTE
The MFP must be connected to a Network server to enable Scan to Shared 
Folder to be set up. Refer to the Configuration Guide for details.

NOTE
Profiles can be created and managed using the machine’s web page or the MFP 
Setup Tool.

You can create up to 50 profiles. Refer to “Managing profiles” on page 76.

FEATURE OPTION DESCRIPTION

Select Profile

Scan Setting Scan Size A4, A5, A6, B5, B6, Letter, Legal 13,
Legal 13.5, Legal 14, Executive, 
Statement, 8.5SQ, Folio

Allows you to select the scan 
size.

Duplex Scan OFF, Long Edge Bind, Short Edge 
Bind

Select the bound originals 
binding position.
Note: A6 duplex scan is not 
supported.

Image Settings Density -3, -2, -1, 0, +1, 
+2, +3

Adjust density
Darker: Keep color intensity 
and darker image.
Lighter: Reduce color 
intensity and gives lighter 
image.

Document 
Type

Text, Text&Photo, 
Photo, Photo 
(Glossy)

Allows you to specify the 
type of images on the 
document.
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Scan Setting
(cont.)

Image Settings
(cont.)

Background 
Removal

Auto, OFF, 1, 2, 3, 
4, 5, 6

Allows you to block out the 
color background of the 
image (assuming document 
has a color background) - 
such that the background 
color is not printed.

Show-
Through 
Removal

OFF, Low, Middle, 
High 

Adjusts the level of show-
through removal.
Note: It is available only 
when “Background Removal” 
is set to “Auto” and 
“Document Type” is “Text” or 
“Text&Photo”.

Resolution 75dpi, 100dpi, 
150dpi, 200dpi, 
300dpi, 400dpi, 
600dpi

Allows you to select the 
appropriate resolution.
Remember the higher the 
resolution the bigger the file size!

Contrast -3, -2, -1, 0, +1, 
+2, +3

Contrast setting
High: Enhance brightness
Low: Reduce brightness

Hue -3, -2, -1, 0, +1, 
+2, +3

Red/green balance 
adjustment.
Low: Enhance red.
High: Enhance green.

Saturation -3, -2, -1, 0, +1, 
+2, +3

Saturation setting
High: Enhance image 
sharpness
Low: Reduce hue

RGB Red: -3, -2, -1, 0, 
+1, +2, +3
Green: -3, -2, -1, 
0, +1, +2, +3
Blue: -3, -2, -1, 0, 
+1, +2, +3

Adjust RGB contrast settings. 
Use the arrow keys to 
increment and decrement 
the values and to move to 
the next color setting.

File Name User defined Use the on-screen keyboard to 
enter an appropriate file name.

Subfolder User defined Enter the subdirectory where 
the scanned document will 
be stored.

Continuous 
Scan

ON, OFF Allows you to continue 
scanning more documents. 
Allows you to construct a 
single scan job from multiple 
individual sheets or originals. 
Refer to “Continuous scan 
mode” on page 109 for 
details.

Grayscale ON, OFF Select ON to print in 
grayscale.

FEATURE OPTION DESCRIPTION
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7. Press the Mono button to scan your document(s) in black and white, or the Color 
button to scan your document(s) in color.

On completion the machine will beep and a confirmation message displays.

8. If access control is enabled, logout once you are finished to avoid any unauthorised 
access.

Scan Setting
(cont.)

File Format Color:
Single-PDF, Multi-PDF, Single-HC-
PDF, Multi-HC-PDF, Multi-PDF/A, 
Single-TIFF, Multi-TIFF, JPEG, XPS
Mono (Grayscale):
Single-PDF, Multi-PDF, Single-HC-
PDF, Multi-HC-PDF, Multi-PDF/A, 
Single-TIFF, Multi-TIFF, JPEG, XPS
Mono (Binary):
Single-PDF, Multi-PDF, Multi-PDF/A, 
Single-TIFF, Multi-TIFF, XPS

Select the appropriate file 
format.

Encrypted PDF Not Encrypt
Encrypt Low, Medium, High

Select the appropriate 
encryption level.

Compression 
Rate/Color, 
Grayscale

High, Medium, Low Select the appropriate 
compression level.

Edge Erase ON, OFF Use the keypad to enter the 
width settings.
Input range: 5 to 50mm

NOTE
If you wish to cancel the scan process, press the Stop button to abort the 
operation.

FEATURE OPTION DESCRIPTION
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SCAN TO USB MEMORY

1. Plug the USB memory into the USB port at the front of the machine.

2. Place your document(s) with text face UP in the ADF or face DOWN on the glass.

3. Press the Scan button on the control panel to prompt the Scan Menu screen.

4. Using the Down arrow key, scroll to USB Memory and press OK.

Using the options available, you can enter a file name and alter the scan output to 
suit your needs. 

FEATURE OPTION DESCRIPTION

Scan Size A4, A5, A6, B5, B6, Letter, Legal 13, Legal 13.5, 
Legal 14, Executive, Statement, 8.5SQ, Folio

Allows you to select the scan size.

Duplex Scan OFF, Long Edge Bind, Short Edge Bind Select the bound originals binding position.
Note: A6 duplex scan is not supported.

Image Settings Density -3, -2, -1, 0, +1, +2, +3 Adjust density
Darker: Keep color intensity and darker 
image.
Lighter: Reduce color intensity and gives 
lighter image.

Document Type Text, Text&Photo, 
Photo, Photo (Glossy)

Allows you to specify the type of images 
on the document.

Background 
Removal

Auto, OFF, 1, 2, 3, 4, 
5, 6

Allows you to block out the color 
background of the image (assuming 
document has a color background) - 
such that the background color is not 
printed.

Show-Through 
Removal

OFF, Low, Middle, High Adjusts the level of show-through 
removal.
Note: It is available only when 
“Background Removal” is set to “Auto” 
and “Document Type” is “Text” or 
“Text&Photo”.

Resolution 75dpi, 100dpi, 150dpi, 
200dpi, 300dpi, 400dpi, 
600dpi

Allows you to select the appropriate 
resolution.
Remember the higher the resolution the 
bigger the file size!

Contrast -3, -2, -1, 0, +1, +2, +3 Contrast setting
High: Enhance brightness
Low: Reduce brightness
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5. Press the Mono button to scan your document(s) in black and white, or the Color 
button to scan your document(s) in color.

On completion a confirmation message displays.

6. Remove the USB memory from the machine.

7. If access control is enabled, logout once you are finished to avoid any unauthorised 
access.

Image Settings 
(cont.)

Hue -3, -2, -1, 0, +1, +2, +3 Red/green balance adjustment.
Low: Enhance red.
High: Enhance green.

Saturation -3, -2, -1, 0, +1, +2, +3 Saturation setting
High: Enhance image sharpness
Low: Reduce hue

RGB Red: -3, -2, -1, 0, +1, 
+2, +3
Green: -3, -2, -1, 0, +1, 
+2, +3
Blue: -3, -2, -1, 0, +1, 
+2, +3

Adjust RGB contrast settings. Use the 
arrow keys to increment and decrement 
the values and to move to the next color 
setting.

File Name User defined Use the on-screen keyboard to enter an 
appropriate file name.

Continuous 
Scan

ON, OFF Allows you to continue scanning more 
documents. Allows you to construct a 
single scan job from multiple individual 
sheets or originals. Refer to “Continuous 
scan mode” on page 109 for details.

Grayscale ON, OFF Select ON to print in grayscale.

File Format Color:
Single-PDF, Multi-PDF, Single-HC-PDF, Multi-
HC-PDF, Multi-PDF/A, Single-TIFF, Multi-TIFF, 
JPEG, XPS
Mono (Grayscale):
Single-PDF, Multi-PDF, Single-HC-PDF, Multi-
HC-PDF, Multi-PDF/A, Single-TIFF, Multi-TIFF, 
JPEG, XPS
Mono (Binary):
Single-PDF, Multi-PDF, Multi-PDF/A, Single-
TIFF, Multi-TIFF, XPS

Select the appropriate file format.

Encrypted PDF Not Encrypt
Encrypt Low, Medium, High

Select the appropriate encryption level.

Compression 
Rate/Color, 
Grayscale

High, Medium, Low Select the appropriate compression level.

Edge Erase ON, OFF Use the keypad to enter the width 
settings.
Input range: 5 to 50mm

NOTE
If you wish to cancel the scan process, press the Stop button to abort the 
operation.

FEATURE OPTION DESCRIPTION
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SCAN TO COMPUTER

You can save the scanned data into your local computer. 

When you press the  or  , the scan job starts and the ActKey utility and the 
TWAIN driver start automatically. You can send the scanned document to a specified 
application, save it in a specified folder, or send it by fax. 

In the WSD Scan connection, you can set an application to start and a location where you 
send or store document for each recipient.

The machine can be connected to USB interface or network, but only a computer can be 
connected at the same time.

If the Mac OS X is running, the image capture and the ICA driver start up automatically.

You can select a folder and save the scanned documents in it.

NOTE
Connect the machine to a computer via USB or a network.
Install ActKey and scanner driver before scanning to a local computer.
If you conect the machine to network, follow these instructions.

> Set TCP/IP setting to Enable.
> Conform the IP version of the machine to that of your computer.
> Set up the DNS server.
> Enable the network TWAIN setting.

If the Mac OS X is running, you can scan a document in the fixed A4 size only 
on the document glass.
If the Mac OS X is running, you can save a file only as JPEG. 
If the Mac OS X is running and if you scan documents through network 
connection, you need to start the image capture first. Then, you need to 
select the machine from the list displayed at the left of image capture screen.
To use the MFP in WSD Scan connection, set the followings.

> Set the TCP/IP setting of the MFP to Enable.
> Match the IP version between the MFP and the PC.
> Enable the WSD Scan.
> Install the MFP on the PC.

REFERENCE
For details on how to enable the network TWAIN setting, refer to the 
Configuration Guide.

For details on how to install the ActKey utility, refer to the Configuration Guide.

For the procedure to enable WSD Scan, see the Configuration Guide.

For the procedure to install the MFP on the PC, see “Setup to use the WSD 
Scan” on page 56.

MONO COLOR
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CONNECTING VIA USB
1. Press the SCAN key on the operator panel.

2. Place your document with text face up in the ADF or face down on the document 
glass.

3. Press the  to select Computer and then press OK.

If the Network TWAIN setting is set to Disable, proceed to the step 6.

4. Check that Select A Connecting PC is selected and then press OK.

5. Press the  to select From USB Interface and then press OK.

6. Press the  to select Select An Application and then press OK.

7. Press the  to select where to send the scanned document and then press OK.

Selectable location Values to send:

8. Press  or .

CONNECTING VIA NETWORK 
1. Press the SCAN key on the operator panel.

2. Place your document with text face up in the ADF or face down on the document 
glass.

3. Press the  to select Computer and then press OK.

4. Check that select Select A Connecting PC is selected and then press OK.

5. Check that From Network is selected and then press OK.

6. Press the  to select the computer you want and then press OK.

7. Press the  to select Select An Application and then press OK.

8. Press the  to select where to send the scanned document and then press OK.

Application       Folder        PC-FAX

NOTE
If the Mac OS X is running, you can select Folder only.

MEMO
If you select Application, the specified application starts and the scanned 
image is displayed on the application.

If you select Folder, the scanned image is saved in the specified folder.

If you select PC-FAX, the application for fax transmission starts. After sending 
the scanned image, send a fax with the fax transmission software on your 
computer.

MONOMONO COLORCOLOR
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9. Press  or . 

WSD SCAN CONNECTION

1. Press the SCAN key on the Operation Panel.

2. Place the original on the automatic document feeder or on the scanner glass.

3. Press the  to select Computer and then press OK.

4. Check that the Select A Connecting PC is selected, and press OK.

5. Press the  to select From WSD Scan and then press OK.

6. Press the  to select the destination PC and then press OK.

7. Press the  to select Duplex Scan and then press OK.

8. Press the  or  to select ON or OFF and then press OK.

9. Press  or .

MEMO
If you select Application, the specified application starts and the scanned 
image is displayed on the application.

If you select Folder, the scanned image is saved in the specified folder.

If you select PC-FAX, the application for fax transmission starts. After sending 
the scanned image, send a fax with the fax transmission software on your 
computer.

MEMO
To start the dual-sided scan, turn its setting On and place the original on the 
automatic document feeder. If you turn the dual-sided scan On but place the 
document on the scanner glass, you cannot scan the dual sides of document.

When using the scanner application on PC, it will be scanned by the scanner 
type of scan profile setup on PC, regardless of where the document is set or 
the setting of Duplex Scan. (A6 is only simplex scanning)

MONOMONO COLORCOLOR

MONOMONO COLORCOLOR
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REMOTE SCAN

This will launch the Scanner driver from a utility installed on the PC (ActKey, PaperPort, 
Image, Adobe Photoshop, etc.) and will begin scanning. 
Connect the machine to a computer via USB or a network. 
TWAIN (USB connection and Network connection) and WSD Scan are supported.

There are 3 Modes of Operation: Simple Scan Mode, Manual Scan Mode, and Secure Scan 
Mode.

In Simple Scan Mode, the scanning can be started from all computers via USB, Network 
and WSD Scan connection,  without special operation on the operator panel.
In Manual Scan Mode, the scanning can be started from all computers via USB, Network 
and WSD Scan connection.
In Secure Scan Mode, the scanning can only be started from selected machine among the 
already registered computers in the machine via USB, Network and WSD Scan connection.

Only one computer can be connected at the same time.

MEMO
For the following procedure, ActKey will be used as an example for Windows, 
and Adobe Photoshop for Mac OS X. The items in this manual may differ 
depending on the application you are using.

NOTE
Connect the machine to a computer via USB or a network.
Install an application (ActKey, PaperPort, etc.) and a scanner driver before 
starting a scan job. This installation is NOT required for WSD Scan 
connection.
If you connect the machine to network, follow these instructions.

> Set TCP/IP setting to Enable.
> Conform the IP version of the machine to that of your computer.
> Set up the DNS server.
> Enable the network TWAIN setting.

When in Secure Scan Mode, the administrator needs to register the computer 
information for carrying out security scans from the control panel or the web 
site beforehand.
For Mac OS X, when carrying out a network scan for the first time, you need 
to set the connection target when using a driver. When you use the driver for 
the first time, the connection target selection tool will launch. You do not 
need to set the connection target after the first time.
To operate the MFP in the WSD Scan connection, set the followings.

> Set the TCP/IP setting of the MFP to Enable.
> Match the IP version between the MFP and the PC.
> Enable the WSD Scan.
> Install the MFP on the PC.

REFERENCE
For details on how to install a scanner driver, refer to “Installing scanner 
drivers (TWAIN/WIA/ICA driver)” on page 50.
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SIMPLE SCAN MODE

For Windows
1. Place your document with text face up in the ADF or face down on the document glass.
2. Start ActKey on your computer.
3. Click the scan button you want.

The scan job starts.

Scan Button Name:

For Mac OS X
1. Place your document with text face up in the ADF or face down on the document glass.
2. Start Image Capture on your computer.
3. Select the device.
4. Click a scan button.

Scanning starts.
5. Select Quit Image Capture from Image Capture.

For WSD Scan
1. Place your document with text face up in the ADF or face down on the document glass.

2. Start any scan program on the PC.

3. Click a scan button. The document scan starts.

MANUAL SCAN MODE

For Windows
1. Press the SCAN key on the operator panel.

2. Place your document with text face up in the ADF or face down on the document glass.

3. Press the  to select Remote Scan and then press OK.

4. Check that the TWAIN is selected, and press OK.

NOTE
If you failed to start scan, please check whether the panel is in operation.

Application1, Application2, Folder, PC-Fax

MEMO
If you select Application1 or Application2, the specified application starts and 
the scanned document is displayed on the application.

If you select Folder, the scanned document is saved in the specified folder.

If you select PC-FAX, the application for fax transmission starts and the 
scanned document is sent to the application. Send a fax with the fax 
transmission software on your computer.
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5. Start ActKey on your computer.

6. Click the scan button you want.

The scan job starts.

Scan Button Name:

For Mac OS X 
1. Press the SCAN key on the operator panel.

2. Place your document with text face up in the ADF or face down on the document glass.

3. Press the  to select Remote Scan and then press OK.

4. Check that the TWAIN is selected, and press OK.

5. Start Image Capture on your computer.

6. Select the device.

7. Click a scan button.

Scanning starts.

8. Select Quit Image Capture from Image Capture.

For WSD Scan
1. Press the SCAN key on the Operation Panel.

2. Place the original on the automatic document feeder or on the scanner glass.

3. Press the  to select Remote Scan and then press OK.

4. Press the  to select WSD Scan and then press OK.

5. Start any scan program on the PC.

6. Click a scan button. The document scan starts.

SECURE SCAN MODE (FOR NETWORK CONNECTION)

For Windows
1. Press the SCAN key on the operator panel.

2. Place your document with text face up in the ADF or face down on the document glass.

3. Press the  to select Remote Scan and then press OK.

4. Check that the TWAIN is selected, and press OK.

5. Check that Select a connecting PC is selected and then press OK.

6. Check that From Network is selected and then press OK.

Application1, Application2, Folder, PC-Fax

MEMO
If you select Application1 or Application2, the specified application starts and 
the scanned document is displayed on the application.

If you select Folder, the scanned document is saved in the specified folder.

If you select PC-FAX, the application for fax transmission starts and the 
scanned document is sent to the application. Send a fax with the fax 
transmission software on your computer.
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7. Press the  to select the destination you want and then press OK.

8. Press  or .

9. Start the ActKey on your computer.

10. Click a scan button.

For Mac OS X 
1. Press the SCAN key on the operator panel.

2. Place your document with text face up in the ADF or face down on the document glass.

3. Press the  to select Remote Scan and then press OK.

4. Check that the TWAIN is selected, and press OK.

5. Check that Select a connecting PC is selected and then press OK.

6. Check that From Network is selected and then press OK.

7. Press the  to select the destination you want and then press OK.

8. Press  or .

9. If your device’s PC Scan Mode is set to Secure Scan Mode, you must use the Network 
Scanner Setup Tool to make the following settings:

>The address of your Mac must be registered with your device.

>The port number used for scanning must be registered. This port number can be 
changed in your device’s “Network Scan Destination” settings.

The Network Scanner Setup Tool is installed in the following location: 
/Applications/OKIDATA/Scanner/

Start the Network Scanner Setup Tool, select your MFP device and change the 
settings. 

10. Start Image Capture on your computer.

11. Select the device.

12. Click a scan button.

Scanning starts.

13. Select Quit Image Capture from Image Capture.

For WSD Scan
1. Press the SCAN key on the Operation Panel.

2. Place the original on the automatic document feeder or on the scanner glass.

3. Press the  to select Remote Scan and then press OK.

4. Press the  to select WSD Scan and then press OK.

5. Start any scan program on the PC.

6. Click a scan button. The document scan starts.

MONOMONO COLORCOLOR

MONOMONO COLORCOLOR
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SECURE SCAN MODE (FOR USB CONNECTION)

For Windows
1. Press the SCAN key on the operator panel.

2. Place your document with text face up in the ADF or face down on the document glass.

3. Press the  to select Remote Scan and then press OK.

4. Check that the TWAIN is selected, and press OK.

5. Check that Select a connecting PC is selected and then press OK.

6. Press the  to select From USB interface and then press OK.

7. Press  or .

8. ActKey start on the computer.

9. Click the Scan button.

For Mac OS X
1. Press the SCAN key on the operator panel.

2. Place your document with text face up in the ADF or face down on the document glass.

3. Press the  to select Remote Scan and then press OK.

4. Check that the TWAIN is selected, and press OK.

5. Check that Select a connecting PC is selected and then press OK.

6. Press the  to select From USB interface and then press OK.

7. Press  or .

8. Start Image Capture on your computer.

9. Select the device.

10. Click a scan button.

Scanning starts.

11. Select Quit Image Capture from Image Capture.

MONOMONO COLORCOLOR

MONOMONO COLORCOLOR
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MANAGING PROFILES

ADDING A NEW NETWORK PROFILE

Register the information you configured on the computer as a profile. It is necessary when 
you perform Scan To Shared Folder with the computer.

1. Press the SETTING button on the control panel to prompt the Setting screen.

2. Using the Down arrow key, scroll to Profile and press OK.

3. Select the desired profile number.

4. Press the Right arrow key to prompt the Operation Menu screen.

From here you can register or sort profiles.

5. When registering a new profile, press the Right arrow key to prompt the Profile 
screen.

6. Ensure Profile Name: is highlighted then press the Right arrow key.

7. Using the arrow keys and on-screen keypad, enter a suitable profile name.

8. Using the arrow keys, highlight Done and press OK.

9. Using the Down arrow key, scroll to Target URL then press the Right arrow key.

10. Using the arrow keys and on-screen keypad, enter the name of the destination 
computer and the shared folder name as “\\name of the destination 
computer\shared folder name”.

11. Using the arrow keys, highlight Done and press OK.

12. Using the Down arrow key, scroll to User Name then press the Right arrow key.

13. Using the arrow keys and on-screen keypad, enter a suitable user name.

14. Using the arrow keys, highlight Done and press OK.

15. Using the Down arrow key, scroll to Password then press the Right arrow key.

16. Using the arrow keys and on-screen keypad, enter a suitable password.

17. Using the arrow keys, highlight Done and press OK.

18. Using the Down arrow key, scroll to File Name then press the Right arrow key.

19. Using the arrow keys and on-screen keypad, enter a suitable file name.

20. Using the arrow keys, highlight Done and press OK.

21. Configure other items if necessary, for example:
\\PC1\SalesDev

22. Press OK to register the settings and save the profile entry.

The setup for Scan To Shared Folder is complete.

NOTE
If domain management is done, enter “user name@domain name”.

NOTE
You can enter up to 64 characters.

By adding “#n” to the end of the file name, a serial number is automatically 
assigned to the end of the name of sent files.

By adding “#d” to the end of the file name, a date is automatically assigned 
to the end of the name of sent files.
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DELETING A NETWORK PROFILE

To delete a network profile:

1. Press the SETTING button on the control panel to prompt the Setting screen.

2. Using the Down arrow key, scroll to Profile List and press OK.

3. Select the desired profile number.

4. Ensure Delete is highlighted then press the Right arrow key.

5. At the prompt:

> press OK to continue deleting the profile entry,

or...

> use the Right arrow key to highlight No, then press OK to cancel.
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MANAGING THE ADDRESS BOOK

SETTING SENDER AND REPLY TO E-MAIL ADDRESSES (FROM/REPLY TO)
You can set the E-mail address from which E-mails are sent and the address to which 
responses are sent.

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and then press OK.

3. Using the arrow keys and on-screen keyboard, enter the administrator password.

4. Select Done and then press OK.

5. Using the Down arrow key, scroll to Scanner Setup and then press OK.

6. Using the Down arrow key, scroll to E-mail Setup and then press OK.

7. Using the Down arrow key, scroll to From/Reply to and then press OK.

8. Using the Down arrow key, scroll to From or Reply to and then press OK.

9. Using the on-screen keyboard, enter the E-mail address up to 48 characters.

10. Select Done and then press OK.

11. Using the Down arrow key, scroll to Close and then press OK.

12. Press the RESET/LOGOUT button.

NOTE
The default password is “999999”.

NOTE
You can select E-mail addresses from the address book.
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CREATING E-MAIL TEMPLATES

You can create up to five E-mail templates with various subject lines and body text.

Registering a subject
1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and then press OK.

3. Using the arrow keys and on-screen keyboard, enter the administrator password.

4. Select Done and then press OK.

5. Using the Down arrow key, scroll to Scanner Setup and then press OK.

6. Using the Down arrow key, scroll to E-mail Setup and then press OK.

7. Using the Down arrow key, scroll to Template and then press OK.

8. Make sure that Edit Subject is selected and then press OK.

9. Using the Down arrow key, select a template entry number and then press OK.

10. Using the on-screen keyboard, enter the subject up to 80 characters.

11. Select Done and then press OK.

Registering body text
1. Follow steps 1 to 7 in “Registering a subject” on page 79.

2. Using the Down arrow key, scroll to Edit Body and then press OK.

3. Using the on-screen keyboard, enter the body text up to 256 characters.

4. Select Done and then press OK.

NOTE
The default password is “999999”.
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ADDING AN E-MAIL ADDRESS ENTRY TO THE ADDRESS BOOK

The machine can hold up to 300 E-mail addresses in the address book. To assign a new 
E-mail address to the address book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Press OK to select E-mail Address.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Register.

6. Press the Right arrow key to select Name.

7. Using the keypad or arrows keys and the on-screen keypad, type in the name.

8. Highlight Done and press OK.

9. Using the Down arrow key, scroll to E-mail Address and press the Right arrow 
key.

10. Using the keypad or arrows keys and the on-screen keypad, type in the new E-mail 
address.

11. Highlight Done and press OK.

12. If required, use the arrow keys and scroll to Group No. then press the Right arrow 
key.

13. Using the arrow keys, select the group number to assign the E-mail address to and 
press OK.

The check box is selected. You can select multiple entries.

14. Press the Right arrow key to complete.

15. Press OK to confirm.

16. Press OK once more to add your entry to the address book.

17. Press the Left arrow key to exit the menu.

DELETING AN E-MAIL ADDRESS ENTRY FROM THE ADDRESS BOOK

To delete an E-mail address entry from the address book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Press OK to select E-mail Address.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Using the arrow keys, scroll to Delete and press OK.

6. At the prompt select Yes to continue or select No to cancel the operation.

7. Press OK.

NOTE
The maximum length of name is 16 characters.

If you do not enter a name, this column remains blank.

NOTE
The maximum length of address is 80 characters.
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8. Press the Left arrow key to exit the menu.

MODIFYING AN E-MAIL ADDRESS ENTRY FROM THE ADDRESS BOOK

To edit an E-mail address entry from the address book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Press OK to select E-mail Address.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Edit.

6. Modify the Name, E-mail Address and/or Group No. details as required then press 
OK.

7. Press the Left arrow key to exit the menu.

ADDING A GROUP ENTRY TO THE ADDRESS BOOK

The machine can hold up to 20 group addresses. To add a new group address to the address 
book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Using the Down arrow key, scroll to E-mail Group and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Register.

6. Press the Right arrow key to select Name.

7. Using the keypad or arrows keys and the on-screen keypad, type in the name.

8. Highlight Done and press OK.

9. Using the Down arrow key, scroll to Address No. and press the Right arrow key.

10. Using the arrow keys, select the destination to assign the E-mail group to and press 
OK.

The check box is selected. You can select multiple entries.

11. Press the Right arrow key to complete.

12. Press OK to confirm.

13. Press OK once more to add your entry to the address book.

14. Press the Left arrow key to exit the menu.

NOTE
The maximum length of name is 16 characters.
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DELETING A GROUP ADDRESS ENTRY FROM THE ADDRESS BOOK

To delete a group address entry from the address book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Using the Down arrow key, scroll to E-mail Group and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Using the arrow keys, scroll to Delete and press OK.

6. At the prompt select Yes to continue or select No to cancel the operation.

7. Press OK.

8. Press the Left arrow key to exit the menu.

MODIFYING A GROUP ADDRESS ENTRY FROM THE ADDRESS BOOK

To edit a group address entry from the address book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Address Book and press OK.

3. Using the Down arrow key, scroll to E-mail Group and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Edit.

6. Modify the Name and/or Address No. details as required then press OK.

7. Press the Left arrow key to exit the menu.
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PRINTING

This chapter details how to use the following print options from the control panel:

> Job Lists

> Print from USB memory

> Switch Online/Offline

For full details of how to use your machine and any optional accessories to print jobs 
efficiently and effectively, please refer to the Printing Guide and the Barcode Printing Guide.

JOB LISTS

You can cancel a print job by deleting it from the job list:

1. Press the Print button (1) on the control panel to prompt the Print Menu screen.

2. Press OK to select Job Lists.

3. Using the arrow keys, scroll to the job you want to cancel and then press OK.

NOTE
If your Administrator has enabled access control on your machine, it will 
automatically start up in access control mode. You will not be able to use it 
until you have provided valid login information. Refer to “User authentication 
and access control” on page 38 for details.

2 3 4

1
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PRINT FROM USB MEMORY

BASIC OPERATION

1. Plug the USB memory into the USB port at the front of the machine.

2. Press the Print button (1) on the control panel to prompt the Print Menu screen.

3. Using the Down arrow key, scroll to Print From USB Memory and press OK.

4. Ensure Select Print File is highlighted, then press OK.

The list of supported files on the USB stick are display.

NOTE
Supported file systems: FAT12, FAT16, FAT32.

Supported file formats: JPEG, PDF (v1.7), M-TIFF (v6 Baseline), XPS, PRN 
(PCL, PS, XPS).

Supported: Up to 32 GB capacity of USB memory.

Not Supported: USB hubs, external USB HDDs and encrypted PDFs.

NOTE
Up to 100 files in supported file formats stored in USB memory are displayed 
on the file list. If more files are stored in USB memory, the list of the stored 
files may not be displayed properly.

You can select and print one file in your USB memory at a time.

2 3 4

1
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5. If your file is contained within a folder:

(a) Using the arrow keys, scroll to the required folder and press OK.

(b) Press OK to select Open Folder.

6. Using the arrow keys scroll to the file you want to print and press the OK.

7. Ensure Select is highlighted, then press OK.

8. If required, scroll to Print Setup and configure the print settings then press OK. 
Refer to “Advanced operation” on page 85 for details.

9. Press Mono (2) to print your document(s) in black and white, or Color (3) to print 
your document(s) in color.

10. Remove the USB memory from the port after a message is displayed indicating that 
it is OK to remove the USB memory.

ADVANCED OPERATION

Using the options available you can alter the print output to suit your needs:

1. Select required parameter with Down arrow key and press the OK button or the 
Right arrow key to display the available options.

2. Using Up or Down arrow keys, select value and press OK.

Options are (factory default settings in bold text):

3. Press the Back button to return to the print menu.

NOTE
If required, scroll to Folder Property and press OK to check the file 
information.

NOTE
If required, scroll to File Property and press OK to check the file information.

NOTE
If you wish to cancel the print process, press Stop (4) to abort the operation.

PARAMETER VALUE DESCRIPTION

Paper Feed Tray 1(A4), MP Tray(A4) Allows you to define the paper tray for 
printing.

Copies 1 Enter the number of copies of a document to 
be printed from 1 to 999.

Duplex OFF, Long Edge Bind, Short Edge 
Bind

Select the duplex copy method.

Fit ON, OFF Match the page size to the paper size. If the 
page size of your file is larger or smaller than 
the effective print area, the page is resized to 
fit the paper size.
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SWITCHING ONLINE/OFFLINE

If you wish to alter the print status of your machine:

1. Press the Print button (1) on the control panel to prompt the Print Menu screen.

2. Using the Down arrow key, scroll to Switch Online/Offline and press OK.

3. Using the arrow keys, scroll to your required option and press OK.

PRINTING WITH AirPrint
AirPrint-enabled applications can print to an AirPrint-enabled device. You don't need to 
install a driver.

Tap print, select a AirPrint-enabled device, and print.

PRODUCTS AFFECTED

> iPhone, iPad, or iPod touch with iOS 4.2 or later

> MAC OSX 10.8.5 or later

HOW TO PRINT

1. Connect using Network.

AirPrint supports wireless connections that use infrastructure mode.

2. Print from applications such as Apple iBook, E-mail, photos, and Safari, etc.

Tap the control icon, and then tap the “Print” button. Select the printer, and then set 
the printer options, and tap the “Print” button.

NOTE
If you switch the machine Offline it will disable the Copy function also.

2 3 4

1
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FAXING 

SENDING A FAX FROM THE MFP
This section details how to send a fax directly from your MFP.

BASIC OPERATION

1. Place your document(s) with text face UP in the ADF or face DOWN on the glass.

2. Press the Fax button (1) on the control panel to prompt the Fax Mode screen.

3. Ensure Fax is highlighted, then press OK.

4. Set your destination and send properties as required. Refer to “Advanced operation” 
on page 88 for details.

5. Press the Mono button (2) to start sending your document(s).

NOTE
If your Administrator has enabled access control on your machine, it will 
automatically start up in access control mode. You will not be able to use it 
until you have provided valid login information. Refer to “User authentication 
and access control” on page 38 for details.

When faxing, you can load only A4, letter, or legal size documents in the ADF, 
and A4 or letter size documents on the document glass. You cannot load mixed 
size documents.

NOTE
If you wish to cancel faxing, press Stop (3) to abort the operation. 
You can cancel a job that is being transmitted as long as the message 
indicating the job has been completed has not displayed. Refer to “Fax job 
view/cancel” on page 97 for details on how to cancel a reserved job.

When you select a broadcast job, the job itself is cancelled. If you want to 
cancel an individual destination within a broadcast job, refer to “Deleting 
specified destinations” on page 90.

Fax transmissions are sent in black and white only.

2 3

1
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ADVANCED OPERATION

Using the options available, you can alter the fax output to suit your needs:

FEATURE OPTION DESCRIPTION

Fax

Add Destination Speed Dial List Select the required speed dial number.
You can select multiple entries.
Entries must be registered in advance, refer 
to “Adding a speed dial entry to the phone 
book” on page 100.

Group List Select the required group dial number.
You can select multiple entries.
Entries must be registered in advance, refer 
to “Adding a group entry to the phone book” 
on page 101.

Direct Input Enter the destination fax number, a pause and 
the tone dialing by the using the keypad:
> Pause (press # key twice. A P appears on the 

screen) pauses two seconds when dialing. You 
can use multiple pauses.

> Tone (press * key twice. A T appears on the 
screen) switches to tone dialing if pulse dialing 
is selected.

Use the Arrow keys and the OK button to 
select dialing function from the on-screen 
options:
> - (Hyphen) Inserts a hyphen to the entered fax 

number.
> PreFix Inserts a prefix number registered in 

advance.
> Flash Notify a PBX of a switch to a public 

telephone line.

Tx History Select a destination from the ten most recent 
transmissions.

Rx History Select a destination from the ten most recent 
receptions.

Fax Functions Scan Size A4, Letter, Legal 13, 
Legal 13.5, Legal 14, 
Folio

Allows you to select the paper size to match 
the document size.

Resolution Normal, Fine, Extra-
Fine, Photo

Allows you to specify the type of images on 
the document. 

Background 
Removal

Auto, OFF, 1, 2, 3, 4, 
5, 6

Allows you to select the setting of document 
background removal (to scan a document 
with background color better): to be adjusted 
automatically, to be adjusted manually in 6 
steps, or not to remove.

Density -3, -2, -1, 0, +1, +2, 
+3

Adjust density
Darker: Keep color intensity and darker image.
Lighter: Reduce color intensity and gives 
lighter image.

Duplex Scan OFF, Long Edge Bind, 
Short Edge Bind

Select the bound originals binding position.

Continuous 
Scan(Document 
Glass)

ON, OFF Allows you to continue scanning more 
documents. Allows you to construct a single 
fax job from multiple individual sheets or 
originals. Refer to “Continuous scan mode” on 
page 109 for details.
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Manual feed
If you wish to send multiple sets of documents from the ADF or flatbed, enable the 
“continuous scan” feature. Refer to “Continuous scan mode” on page 109 for full details.

Fax Functions
(cont.)

Continuous 
Scan(ADF)

ON, OFF Allows you to continue scanning more 
documents. Allows you to construct a single 
fax job from multiple individual sheets or 
originals. Refer to “Continuous scan mode” on 
page 109 for details.

Edge Erase ON, OFF Erases the black shadow around the edge 
when scanning a document like a book.
The range is from 2 mm to 50 mm.

TTI ON, OFF Prints the sender name on the header of the 
transmitted fax. By default, the name you 
specified in Sender ID is printed.

TTI Select user defined Select the user defined TTI header.
Note: TTI must be ON.

Transmit 
Confirmation 
Report

ON, OFF Select ON to print a fax confirmation after 
transmission.

Delayed Tx OFF
Date
Time

Delayed transmission allows you to fax 
documents at a specific date and time.
Up to one hundred transmission times can be 
scheduled up to one month in advance.

Fcode Polling ON, OFF To turn ON, use the numeric keypad to enter 
the sub-address of the remote machine.
If required, use the numeric keypad to enter 
the password of the remote machine.

Fcode Tx ON, OFF F Code transmission is a function to 
communicate using sub addresses or 
passwords in accordance with the standard of 
ITU-T. by creating and registering F Code 
boxes you can execute confidential 
communication and notice board 
communication. 
Use the numeric keypad to enter the sub-
address.
If required, use the numeric keypad to enter 
the password of the remote machine.
Note: up to 20 F code boxes can be 
registered, Up to 30 documents can be stored 
in one box.
Note: Polling and FPolling must be OFF.

Memory Tx ON, OFF Select OFF to enable real time transmission, 
i.e. fax transmission synchronisation with 
scanning.

Fax Job View/
Cancel

View or cancel a reserved fax job from the 
list.

Fax History Tx History Check the transmission or reception history 
and results of a fax job.

Rx History

FEATURE OPTION DESCRIPTION
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Broadcasting
This function allows you to send a fax to multiple recipients at the same time. By combining 
abbreviation dials, groups and entering addresses using the numeric keypad, you can 
specify up to 100 destinations at one time.

Deleting specified destinations

You can cancel an individual destination within a broadcast job.

1. Make sure that the required destination is selected on the fax standby screen and 
then press OK.

2. Using the arrow keys, scroll to the destination you want to delete and then press 
OK.

A check box is selected. You can select multiple entries.

3. When you have selected all the destinations to be deleted, press the Right arrow 
key.

4. Make sure that Delete The Address is selected and then press OK.

Manual redial
Your machine is set to redial automatically, if you wish to manually redial:

1. Press the FAX button on the control panel.

2. Press OK to select Fax.

3. Press OK to select Add Destination.

4. Using the Down arrow key, scroll to Tx History and press OK.

5. Using the arrow keys, scroll to the required destination and press OK.

The check box is selected. You can select multiple entries.

6. When you have selected all the destinations, press the Right arrow key.

7. Press OK to select Complete.

8. Press the Mono button (2) to start sending your document(s).

NOTE
When real time transmission (Memory Tx set to OFF) or polling is executed 
during broadcasting data, they are executed preferentially. In the case of 
polling, it is executed preferentially when there is only one address specified.

When Broadcast Destination is enabled, the destination numbers are 
displayed before transmission.
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F Code communication
F Code transmission is a function to communicate, using sub addresses or passwords in 
accordance with the ITU-T standard. By creating F code boxes/sub addresses/passwords, 
you can execute secure communication, bulletin box communication and polling 
communication.

Sub address and ID code

> A sub address is a number to distinguish various F code boxes that are set in the 
memory.

> An ID code is a key to access a secure box.

By using a sub address, the following functions can be used:

> F Code Confidential Communication

When an F code confidential box is set in the recipient machine, by specifying the sub 
address of its box, confidential communication can be executed.

On the receiving side of the confidential communication, unless the specified ID code 
is entered, a received document cannot be printed, therefore, this function is useful 
when sending a document that needs a security protection. Refer to:

> “Transmission using a sub address (F code transmission)” on page 94.

> “Printing stored documents” on page 96.

> F Code Bulletin Box Communication

When the F code bulletin box is set in the recipient machine, by specifying the sub 
address of its notice board, a document can be sent to the bulletin box or a document 
stored in the bulletin box can be taken out (polling). (A password can be specified, if 
necessary.) Refer to:

> “Transmission using a sub address (F code transmission)” on page 94.

> “Receiving using a sub address (F code polling)” on page 95.

> “Storing documents in a bulletin box” on page 95.

Registering an F code box

To use F code communication, register an F code box. Register a sub address in each F code 
box.

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Enter and press OK.

4. Using the Down arrow key, scroll to Fax Setup and press OK.

5. Using the Down arrow key, scroll to Fcode Box and press OK.

6. Using the arrow keys, scroll to the required entry position and press OK.

7. Press OK to select Register.

NOTE
Up to 20 F code boxes can be registered.

NOTE
Make sure to register a sub address.

When a secret number is set, only the specific person can operate the F code 
box.
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8. Select a type of F code box:

> Bulletin Box - refer to “Registering an F code Bulletin box” on page 92

> Confidential Box - refer to “Registering an F code confidential box” on page 92.

Registering an F code Bulletin box

1. Press OK to select Bulletin Box.

2. Press the Right arrow key to select Box Name.

(a) Using the arrow keys and on screen keyboard, enter a box name.

(b) Highlight Enter and press OK.

3. Using the Down arrow, scroll to Sub-Address and press the Right arrow key.

(a) Using the keypad enter the sub address.

(b) Highlight Enter and press OK.

4. Press OK to complete.

Registering an F code confidential box

1. Press OK to select Confidential Box.

2. Press the Right arrow key to select Box Name.

(a) Using the arrow keys and on screen keyboard, enter a box name.

(b) Highlight Enter and press OK.

3. Using the Down arrow, scroll to Sub-Address and press the Right arrow key.

(a) Using the keypad enter the sub address.

(b) Highlight Enter and press OK.

NOTE
If using one-byte characters, up to 16 characters can be registered.

NOTE
A sub address can be registered using up to 20 digits. Numbers, # and * can 
be registered.

If you make a mistake when entering the digits, press the Clear button to 
delete and then enter the correct digit.

NOTE
If using one-byte characters, up to 16 characters can be registered. If using 
double-byte characters, up to 8 characters can be registered.

NOTE
A sub address can be registered using up to 20 digits. Numbers, # and * can 
be registered.

If you make a mistake when entering the digits, press the Clear button to 
delete and then enter the correct digit.
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4. Using the Down arrow key, scroll to I.D.Code and press the Right arrow key:

(a) Register an ID Code number (4 digits) using the numeric keypad.

(b) Press OK.

5. If required, use the Down arrow key to scroll to Hold Time. Press the Right arrow 
key:

(a) Enter the required hold time (00 ~ 31) using the numeric keypad.

(b) Press OK.

6. Press OK to complete.

NOTE
The ID code is not displayed, write it down and keep it safe!

NOTE
Specify a retention period between 0 and 31 days.

If “00” is specified, the data will be retained for an indefinite period.

Retention period input range is between 0 and 31 days). When 0 is set, 
documents are retained for an indefinite period.
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Deleting an F code box

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Admin Setup and press OK.

3. Using the arrow keys and on-screen keypad, enter the Administrator password. 
Highlight Done and press OK.

4. Using the Down arrow key, scroll to Fax Setup and press OK.

5. Using the Down arrow key, scroll to Fcode Box and press OK.

6. Using the arrow keys, scroll to the required entry position and press OK.

7. Using the Down arrow key, scroll to Delete and press OK.

8. Using the arrow keys, highlight Yes to continue or No to cancel.

9. Press the OK button to execute.

Transmission using a sub address (F code transmission)

By entering a sub address and ID code, F code confidential transmission, F code bulletin 
transmission and F code polling transmission can be performed.

1. Place your document(s) with text face UP in the ADF or face DOWN on the glass.

2. Press the Fax button on the control panel to prompt the Fax Ready screen.

3. Press OK to select Fax.

4. Using the Down arrow key, scroll to Fax Functions and press OK.

5. Using the Down arrow key, scroll to Fcode Tx and press OK.

6. Using the arrow keys, scroll to ON and press OK.

7. Using the numeric keypad, enter the sub-address of the box registered in the 
recipient machine.

8. Highlight Enter and press OK.

9. Press the Left arrow key to exit.

10. Press OK to select Add Destination.

11. Using the arrow keys, scroll to the required destination input method and press OK.

12. Specify a destination.

13. Press OK to complete.

14. Press the Mono button to start sending your document(s).

NOTE
You cannot delete an F code box in which documents are stored, it must be 
empty.

NOTE
Before operating, ensure you have the necessary sub address and ID code to 
hand.
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Receiving using a sub address (F code polling)

By entering a sub address and ID code, a document stored in the bulletin box of a recipient 
machine can be taken out (polling).

1. Press the Fax button on the control panel to prompt the Fax Ready screen.

2. Press OK to select Fax.

3. Using the Down arrow key, scroll to Fax Functions and press OK.

4. Using the Down arrow key, scroll to Fcode Polling and press OK.

5. Using the arrow keys, scroll to ON and press OK.

6. Using the numeric keypad, enter the sub-address of the box registered in the sender 
machine.

7. Highlight Enter and press OK.

8. Press the Left arrow key to exit.

9. Press OK to select Add Destination.

10. Using the arrow keys, scroll to the required destination input method and press OK.

11. Specify a destination.

12. Press OK to complete.

13. Press the Mono button to start receiving your document(s)

Storing documents in a bulletin box

1. Place your document(s) with text face UP in the ADF or face DOWN on the glass.

2. Press the SETTING button on the control panel.

3. Using the Down arrow key, scroll to Store Document Settings and press OK.

4. Press OK to select Store.

5. Press OK to select Fcode Bulletin Board.

6. Select the F code box in which to store the document.

7. Press OK.

8. Confirm the displayed Over Write, and press OK.

> Over Write: replace a document in the box.

9. Using the arrow keys, highlight Yes to continue or No to cancel.

10. Press the OK button to execute.

NOTE
Before operating, ensure you have the necessary sub address and ID code to 
hand.

NOTE
Before operating, ensure you have registered the bulletin box in the F-Code 
box.
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Printing stored documents

Printing received confidential documents.

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Store Document Settings and press OK.

3. Using the Down arrow key, scroll to Print and press OK.

4. Press OK to select Fcode Box.

5. Select the F code box storing the document you want to print.

6. If an ID code is set, enter the number (4 digits) using the numeric keypad. Press 
OK.

7. Select the file number of the document you want to print. Press OK.

8. Using the arrow keys, highlight Yes to continue or No to cancel.

9. Press the OK button to execute.

The document that is stored or received is printed.

Deleting stored documents

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Store Document Settings and press OK.

3. Using the Down arrow key, scroll to Delete and press OK.

4. Press OK to select Fcode Bulletin Board.

5. Select the F code box storing the document you want to delete. Press OK.

6. Select the file number of the document you want to delete. Press OK. 

7. Using the arrow keys, highlight Yes to continue or No to cancel.

8. Press the OK button to execute.

NOTE
When a document is received into an F code box, the F code receiving notice 
is printed.

Check the F code box number and print the stored document.

NOTE
Confidential received documents are automatically deleted after printing.
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Fax job view/cancel
If you no longer require a stored fax job, you can cancel and remove it from your MFP’s 
memory.

1. Press the Fax button on the control panel to prompt the Fax Mode screen.

2. Using the arrow keys, scroll to Fax and press OK.

3. Using the Down arrow key, scroll to Fax Job View/Cancel and press OK.

4. Using the Down arrow key, scroll to the fax job you wish to delete and press OK.

5. Check the job contents, then press the Right arrow key.

6. Using the Down arrow key, scroll to Delete Reserved Tx and press OK.

7. Using the arrow keys, select Yes to continue or No to cancel and press OK.

Fax job reports and listings

FAX RECEIVING

Your MFP is set to receive faxes automatically.

The machine behaviour differs depending on the specified reception mode.

When the machine is receiving faxes, the DATA IN MEMORY indicator is lit and the sender 
information is displayed on screen. The indicator remains lit while the data is stored in 
memory.

Fax ready mode
This is the factory default setting; your machine is set so that it automatically receives 
faxes.

Tel/Fax ready mode
When the machine is set to Tel/Fax Ready Mode, you can receive calls and faxes. You must 
connect an external telephone in advance to receive calls, refer to the Configuration Guide 
for details.

NOTE
When you select a broadcast job, the job itself is deleted. If you wish to cancel 
an individual destination within the broadcast job, refer to “Deleting specified 
destinations” on page 90 for details.

NOTE
If the MFP is actively sending or receiving a fax, then any incoming faxes will 
be rejected.

NOTE
> The sender name and fax number registered on the sender machine are 

displayed on screen.
> If the memory overflows while the machine is receiving data, the 

reception is cancelled. If this happens, ask the sender to resend the fax.



Faxing > 98

Receiving faxes

The machine automatically starts fax reception.

Receiving calls

The telephone starts ringing when it receives calls.

1. Pick up the handset to talk when the machine rings.

2. If necessary, press the mono START button and then put down the handset to 
receive faxes.

Ans/Fax ready mode
When the machine is set to Ans/Fax Ready Mode, you can use an answering machine and 
receive faxes automatically. You must connect an external answering machine in advance, 
refer to the Configuration Guide for details.

Receiving faxes

The machine automatically starts fax reception.

Receiving calls

The answering machine rings, the reply message starts, and then it starts recording a 
message.

Tel ready mode
Tel Ready Mode is recommended if you often use the external telephone connected to the 
machine. You must connect an external telephone in advance to receive calls, refer to the 
Configuration Guide for details.

Receiving calls

The telephone starts ringing when it receives calls.

Receiving faxes

The telephone starts ringing when it receives a signal.

1. Pick up the handset when the machine rings.

2. Press the mono START button and then put down the handset to receive faxes.

NOTE
In case of connecting with far distance telephone, faxes can be received by 
pressing “remote receiver number”. Refer to page 114 of “Configuration 
Guide”.

NOTE
Depending on the answering machine and the sender machine, Ans/Fax 
Ready Mode may not operate correctly.
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DRD
This mode allows the machine to detect a distinctive ring if it has been enabled on the 
phone line. In this mode, the machine distinguishes the DRD type of the sender. The 
machine then answers only when it matches the registered DRD type.

There are several type of DRD ring pattern. The length of ring ON time and ring OFF time 
is different. It depends on the Country Code. Please set the Country Code and DRD Type 
for your suitable DRD ring pattern. You can register up to four DRD types.

Country Code: except New Zealand, Australia and Hong Kong (This pattern is to apply to 
America's DRD.)

Type 1: 2 sec ON - 4 sec OFF repeat

Type 2: 0.8 sec ON - 0.4 sec OFF - 0.8 sec ON - 4 sec OFF repeat

Type 3: 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 0.2 sec OFF - 0.8 sec ON - 4 sec OFF repeat

Type 4: 0.3 sec ON - 0.2 sec OFF - 1 sec ON - 0.2 sec OFF - 0.3 sec ON - 4 sec OFF repeat

Country Code: New Zealand (This pattern is to apply to New Zealand's DRD.)

Type 1: 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 2 sec OFF repeat

Type 2: 0.4 sec ON - 2.6 sec OFF repeat

Type 3: 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 1.4 sec OFF repeat

Type 4: 0.4 sec ON - 0.8 sec OFF - 0.4 sec ON - 1.4 sec OFF repeat

Country Code: Australia (This pattern is to apply to Australia's DRD.)

Type 1: 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 2 sec OFF repeat

Type 2: 0.2 sec ON - 0.4 sec OFF - 0.2 sec ON - 0.4 sec OFF - 0.2 sec ON - 1.6 sec OFF repeat

Country Code: Hong Kong (This pattern is to apply to Hong Kong's DRD.)

Type 1: 1.2 sec ON - 3 sec OFF repeat

Type 2: 0.4 sec ON - 0.2 sec OFF - 0.4 sec ON - 0.2 sec OFF - 0.8 sec ON - 0.4 sec OFF repeat

Type 3: 0.5 sec ON - 0.5 sec OFF - 1 sec ON - 0.5 sec OFF - 0.5 sec ON - 3 sec OFF repeat.

Printing received faxes
The machine automatically prints out the received fax.

Images larger than the specified paper are reduced, discarded, or printed onto multiple sheets 
of paper depending on the reception print settings.

If the machine cannot print received faxes due to a lack of paper or a paper jam, it will 
store the received fax data temporarily it’s memory. When the problem is resolved, it starts 
printing automatically.

NOTE
> Use only standard or recycled paper.
> Available paper sizes are A4, A5, B5, Letter, Legal13/13.5/14, Statement.

NOTE
For details on how to load paper, refer to “Loading paper” on page 33.

For details on how to clear paper jams, refer to “Clearing paper jams” on page 127.

To check the reception history, refer to “Rx History” on page 89.
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MANAGING THE PHONE BOOK

The following section describes how to add/remove/modify speed and group dial entries to/
from the Phone Book.

ADDING A SPEED DIAL ENTRY TO THE PHONE BOOK

The machine can hold up to 300 speed dial numbers in the phone book. To add a new speed 
dial number to the phone book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Press OK to select Speed Dial.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Register.

6. Press the Right arrow key to select Name.

7. Using the keypad or arrows keys and the on-screen keypad, type in the name.

8. Highlight Enter and press OK.

9. Using the Down arrow key, scroll to Fax Number and press the Right arrow key.

10. Using the keypad, type in the destination fax number.

11. Highlight Enter and press OK.

12. If required, use the arrow keys and scroll to Group No. then press the Right arrow 
key.

13. Using the arrow keys, select the group number to assign the fax number to and 
press OK.

The check box is selected. You can select multiple entries.

14. Press the Right arrow key to complete.

15. Press OK to confirm.

16. Press OK once more to add your entry to the phone book.

NOTE
The maximum length of name is 24 characters.

NOTE
The maximum length of number is 40 digits.

If the destination fax number has an “extension number”, press the Pause 
button between numbers. The machine will enter a pause when dialling.

If your MFP is connected to a PBX (private branch exchange), you will need to 
add a Prefix in order to access to the outside line. Refer to the Configuration 
Guide for details.

If you need to change the dialling method for the region, press the Tone 
button to change the call parameters for this particular number.

If you make a mistake while entering the number, press the Clear button to 
delete the last digit.

NOTE
Numbers registered to groups from the Speed Dial function are synchronized 
with the numbers that are registered to groups using the Group No. function.
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17. Press the Left arrow key to exit the menu.

ADDING A GROUP ENTRY TO THE PHONE BOOK

The machine can hold up to 20 group dial settings. To add a new group dial number to the 
phone book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Using the Down arrow key, scroll to Group No. and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Register.

6. Press the Right arrow key to select Name.

7. Using the keypad or arrows keys and the on-screen keypad, type in the name.

8. Highlight Enter and press OK.

9. Using the Down arrow key, scroll to Speed Dial and press the Right arrow key.

10. Using the arrow keys, select the speed dial number you wish to assign to the group 
and press OK.

The check box is selected. You can select multiple entries.

11. Press the Right arrow key to complete.

12. Press OK to confirm.

13. Press OK once more to add your entry to the phone book.

14. Press the Left arrow key to exit the menu.

DELETING A SPEED DIAL ENTRY FROM THE PHONE BOOK

To delete a speed dial entry from the phone book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Press OK to select Speed Dial.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Using the arrow keys, scroll to Delete and press OK.

6. At the prompt select Yes to continue or select No to cancel the operation.

7. Press OK.

8. Press the Left arrow key to exit the menu.

DELETING A GROUP DIAL ENTRY FROM THE PHONE BOOK

To delete a group dial entry from the phone book:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Using the Down arrow key, scroll to Group No. and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

NOTE
The maximum length of name is 16 characters.
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5. Using the arrow keys, scroll to Delete and press OK.

6. At the prompt select Yes to continue or select No to cancel the operation.

7. Press OK.

8. Press the Left arrow key to exit the menu.

MODIFYING A SPEED DIAL ENTRY

To modify a speed dial entry:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Press OK to select Speed Dial.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Edit.

6. Modify the Name, Fax Number and/or Group No. details as required then press OK.

7. Press the Left arrow key to exit the menu.

MODIFYING A GROUP DIAL ENTRY

To modify a group dial entry:

1. Press the SETTING button on the control panel.

2. Using the Down arrow key, scroll to Phone Book and press OK.

3. Using the Down arrow key, scroll to Group No. and press OK.

4. Using the arrow keys, scroll to the required entry position and press OK.

5. Press OK to select Edit.

6. Modify the Name, and/or Speed Dial details as required then press OK.

7. Press the Left arrow key to exit the menu.

REGISTERING AN ENTRY FROM RECEPTION OR TRANSMISSION HISTORY

1. Press the Fax button on the control panel to prompt the Fax Mode screen.

2. Ensure Fax is highlighted, then press OK.

3. Using the Down arrow key, scroll to Fax History and press OK.

4. Using the arrow keys, highlight Tx History or Rx History as appropriate and press 
OK.

5. Using the arrow keys, scroll to the required entry and press OK.

6. Check the entry contents and then press the Right arrow key.

7. Press OK to select Register To Speed Dial.

8. Using the arrow keys, scroll to the required entry position and press OK.

9. Continue the registration process as described in “Adding a speed dial entry to the 
phone book” on page 100.

The fax number is automatically entered. You do not have to enter it manually.
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INTERNET FAX

SENDING A FAX FROM YOUR PC 

Basic operation
1. At the MFP: Place your document(s) with text face UP in the ADF or face DOWN on 

the glass.

2. Press the Fax button on the control panel to prompt the Fax Mode screen.

3. Using the Down arrow key, scroll to Internet Fax and press OK.

4. Set your destination and send properties as required. Refer to “Advanced operation” 
on page 105 for details.

5. At your PC: From your application’s File menu, select Print.

6. In the Select Printer window, highlight the fax driver option.

7. Press the Preferences button to display the fax driver window.

8. On the Setup tab:

(a) Select the appropriate media size from the drop-down menu.

(b) Set the resolution quality to Ext-Fine, Fine or Normal.

(c) Set the orientation to Portrait or Landscape.

9. On the Cover Sheet tab:

(a) Set the cover sheet usage settings as appropriate.

(b) Select a cover sheet format.

10. On the Sender tab:

(a) Enter your name.

(b) Enter your fax number.

NOTE
You must have the fax driver installed on your PC. Download the latest fax 
driver from your support website.
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(c) Enter comments if required.

(d) If required select the Add an outside call number checkbox and enter the 
Outside call number as appropriate.

11. On the Recipient tab:

(a) Click the Recipients... button.

(b) Select a fax number from the Phone book panel on the right hand side. Refer 
to “Adding fax numbers to the phone book” on page 107.

(c) Press the Add button to add this number to the recipient list.

(d) Repeat (b) and (c) as required to create the recipient list.

(e) If you need to remove a number from the recipient list, highlight the appropriate 
name and then press the Delete button.

(f) Once you have completed your list, press the OK button to close the Select 
Recipients window.

12. Press the OK button to close the fax driver window.

13. Press OK to start sending your fax.

NOTE
If you wish to cancel faxing during transmission to the MFP:

1. Double-click the printer icon in the notification area. 

2. Select the job from the print queue.

3. From the Document menu, select Cancel.

Once the job is stored in the MFP, you cannot cancel it from the PC, instead 
you must cancel it directly from the machine. Refer to “Fax job view/cancel” 
on page 97 for details.
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Advanced operation
Using the options available, you can alter the fax output to suit your needs:

FEATURE OPTION DESCRIPTION

Internet Fax

Add
Destination

To:
Cc:

Bcc:

Address Book Select E-mail address from the 
address book.
Input range: 001-300

Group List Select destination group from the 
list.
Input range: 01-20

Tx History Displays the list of sent E-mails.

Direct Input Enter E-mail address using the 
on-screen keyboard.

LDAP Simple Search Use the on-screen keyboard to 
enter a search value.

Advanced Search
Search Method:

User Name:
Email Address:

Use Advanced Search to search 
the LDAP address book by User 
Name and/or E-mail address.

Scan Setting Scan Size A4, Letter, Legal 13, Legal 13.5, 
Legal 14

Allows you to select the paper size 
to match the document size.

Density -3, -2, -1, 0, +1, +2, +3 Adjust density
Darker: Keep color intensity and 
darker image.
Lighter: Reduce color intensity 
and gives lighter image.

Resolution Normal, Fine, Extra-Fine, Photo Allows you to specify the type of 
images on the document. 

Background 
Removal

OFF, 1, 2, 3, 4, 5, 6 Allows you to block out the color 
background of the image 
(assuming document has a color 
background) - such that the 
background color is not printed.

Reply to Address Book Select E-mail address from the 
address book.
Input range: 001-300

Direct Input Enter E-mail address using the 
on-screen keyboard.

LDAP Simple Search Use the on-screen keyboard to 
enter a search value.

Advanced Search
Search Method:

User Name:
E-mail Address:

Use Advanced Search to search 
the LDAP address book by User 
Name and/or E-mail address.

Edit E-mail Subject Select Subject Enter new or edit the default E-
mail subject and text templates.
For further details refer to 
“Creating E-mail templates” on 
page 79.

Direct Input

E-mail Body Select Text

Direct Input
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RECEIVING AN INTERNET FAX

The machine automatically prints the internet faxes it receives. If the document is larger 
than A4 size, the machine automatically reduces it to the size of the paper in the specified 
paper tray.

Scan Setting
(cont.)

File Name User defined Use the on-screen keyboard to 
enter an appropriate file name.

Duplex Scan ON, OFF Turns the duplex (2-sided) 
function off or on.

Continuous 
Scan

ON, OFF Allows you to continue scanning 
more documents. Allows you to 
construct a single fax job from 
multiple individual sheets or 
originals. Refer to “Continuous 
scan mode” on page 109 for 
details.

Compression 
Rate

High, Medium, Low Select the appropriate 
compression level.

Tx History Check the transmission history 
and results of an internet fax job.

FEATURE OPTION DESCRIPTION
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ADDING FAX NUMBERS TO THE PHONE BOOK

To add a fax destination number to the phone book:

1. From your application’s File menu, select Print.

2. In the Select Printer window, highlight the fax driver option.

3. Press the Preferences button to display the fax driver window.

4. Click the Phone book... button.

The phone book screen displays.

5. Select FAX number -> New (FAX number).

6. Type in the fax number destination Name.

7. Type in the required FAX number.

8. If required, type in a Comment.

9. Press the OK button to save.

ADDING NEW GROUPS TO THE PHONE BOOK

To add a new group to the phone book:

1. From your application’s File menu, select Print.

2. In the Select Printer window, highlight the fax driver option.

3. Press the Preferences button to display the fax driver window.

4. Click the Phone book... button.

The phone book screen displays.

5. Select FAX number -> New (Group).

6. Type in the Group name.

7. If required, type in a Comment.

NOTE
you can register up to 1000 destinations.
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8. Add recipients to the group list:

(a) Select a fax number from the Phone book panel on the right hand side.

(b) Press the Add-> button to add this number to the group list.

(c) Repeat steps (a) and (b) as required to create the group list.

(d) If you need to remove a number from the recipient list, highlight the appropriate 
name and then press the <-Delete button.

9. Once you have completed your list, press the OK button to close the New Group 
window.

IMPORTING AND EXPORTING FAX NUMBERS

By using the import and export functions, you can manage fax numbers in a phone book 
created on another computer.

1. In Windows:

Select Start > Devices and Printers.

2. Right-click your machine icon and select Printing Preferences.

3. In the Setup tab, click the Phone Book button.

4. From the pull-down menu, click Tool > Export.

5. In the Export File screen, enter a name for the file and click the Save button. The 
phone book is saved.

6. Import the saved phone book file to the other computer:

(a) In the fax driver installed on the computer that the phone book file was 
imported, start the phone book in the same way, and click Tool > Import in 
the menu.

(b) In the Import File screen, select a phone book file to import. When the Open 
button is clicked, data is imported to the phone book.

NOTE
Maximum 100 recipients in any one group.

NOTE
You can add a new fax number directly by clicking the New (FAX number)... 
button and adding an entry to the phone book panel.

NOTE
This procedure uses Windows 7 and NotePad as an example. The procedures 
and menus may differ depending on the OS you use.

NOTE
Registration of groups cannot be exported. (Destinations included in the group 
are exported.)
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FUNCTIONS COMMON TO COPY, FAX AND SCAN OPERATIONS

CONTINUOUS SCAN MODE

If you need to scan, copy or fax multiple sets of documents from the ADF or document 
glass, enable the “Continuous Scan” option.

To set the fax to continuous scan:

1. Place your document(s) with text face UP in the ADF or face DOWN on the glass.

2. Press the Fax button on the control panel to prompt the Fax Ready screen.

3. Ensure Fax is highlighted, then press OK.

4. Using the Down arrow key, scroll to Fax Functions and press OK.

5. Using the Down arrow key, scroll to Continuous Scan(ADF) or Continuous 
Scan(Document Glass) and press OK.

6. Select ON and press OK.

7. Press the BACK button to exit the menu and return to the Fax Ready screen.

8. Set your send properties as required.

9. Press Mono to start scanning the first document.

Once the current scanning operation is complete, the screen will display “Please set next 
document”. If you have further documents to scan, ensure Start Scan is highlighted then 
press OK to continue scanning or use the Down arrow key to select Scan Complete.

NOTE
The example below uses the fax feature, however, the scan and copy features 
follow the same process.
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MAINTENANCE

REPLACING CONSUMABLE ITEMS

Only use genuine original consumables to ensure the best quality and 
performance from your hardware. Non original products may adversely affect 
your printer's performance and invalidate your warranty.

TONER CARTRIDGE REPLACEMENT

The toner used in this printer is a very fine dry powder. It is contained in four cartridges: 
one each for cyan, magenta, yellow and black.

Have a sheet of paper handy so that you have somewhere to place the used cartridge while 
you install the new one.

Dispose of the old cartridge responsibly, inside the recycle bag that came with the new 
cartridge. Follow any regulations, recommendations, etc., which may be in force 
concerning waste recycling.

If you do spill any toner powder, lightly brush it off. If this is not enough, use a cool, damp 
cloth to remove any residue.

Do not use hot water, and never use solvents of any kind. They will make stains permanent.

When the error message “Caution, unknown Consumable detected” is displayed, you 
can use any consumables in your product, but you must accept the risks of using non-
genuine consumables. If the use of non-genuine consumables causes damage to the 
product or results in your product not functioning to its full specification, then such damage 
or effect on the product is not covered by warranty. To accept these risks and to restore 
function;

1. Turn off your product.

2. Press and hold the CLEAR button and turn your product on.

3. After start up, release the CLEAR button.

NOTE
When the LCD display indicates TONER LOW, or if print appears faded, first 
open the output tray and try tapping the cartridge a few times to evenly 
distribute the toner powder. This will enable you to obtain the best “yield” from 
your toner cartridge.

CAUTION!

To avoid toner wastage and possible toner sensor errors, do not 
change the toner cartridge(s) until “TONER EMPTY” is displayed.

WARNING!

If you inhale any toner or get it in your eyes, drink a little water or 
bathe your eyes liberally in cold water. Seek medical attention 
immediately.

NOTE
This operation will be recorded for future reference.
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1. Gently raise the scanner.

2. Press the cover release (a) and open the output tray (b) fully.

WARNING!

If the MFP has been powered on, the fuser will be hot. This area is 
clearly labelled. Do not touch.

a

b
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3. Note the positions of the four cartridges. It is essential that they go back in the same 
order.

(a) Slide the colored release collar on the cartridge to be replaced fully towards the 
right hand side of the printer.

(b) Lift the right-hand end of the cartridge and then draw the cartridge to the right 
to release the left-hand end as shown, and withdraw the toner cartridge out of 
the printer.

4. Put the cartridge down gently onto a piece of paper to prevent toner from marking 
your furniture.

1. Yellow cartridge 2. Magenta cartridge
3. Cyan cartridge 4. Black cartridge

1

2

3

4

b

a
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5. Clean the top of the ID unit with a clean, lint free cloth.

6. Remove the new cartridge from its box but leave its wrapping material in place for 
the moment.

7. Gently shake the new cartridge from end to end several times to loosen and 
distribute the toner evenly inside the cartridge.

8. Remove the wrapping material.

9. Holding the cartridge by its top centre, lower it into the printer over the image drum 
unit from which the old cartridge was removed.

10. Insert the left end of the cartridge into the top of the image drum unit first, pushing 
it against the spring on the drum unit, then lower the right end of the cartridge down 
onto the image drum unit.

11. Pressing gently down on the cartridge to ensure that it is firmly seated, slide the 
colored collar fully towards the left hand side of the printer. This will lock the 
cartridge into place and release toner into the image drum unit.
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12. Gently wipe the LED head surface with a clean, lint free cloth.

13. Close the output tray and press down firmly so that the cover latches closed. 

14. Gently lower the scanner.

b

c

a
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IMAGE DRUM REPLACEMENT

The image drum assembly comes complete with its own installation details which give full 
instructions on replacement. You are advised to follow these instructions carefully.

REPLACING THE TRANSFER BELT UNIT

The belt unit is located under the image drum assembly.

Switch off the MFP and allow the fuser to cool for about 10 minutes before opening the 
cover. Refer to “Turning off your machine” on page 19 for details.

1. Gently raise the scanner.

2. Press the cover release (a) and open the output tray (b) fully.

3. Holding it by its handles, lift the image drum assembly, complete with toner 
cartridges, up and out of the printer.

WARNING!

If the MFP has been powered on, the fuser will be hot. This area is 
clearly labelled. Do not touch.

a

b
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4. Place the assembly in a safe place away from direct sources of heat and light.

5. Pull the locking levers at each side of the transfer belt up and towards the front of 
the machine.

6. Using the locking levers (a), lift the belt (b) upwards and withdraw from the 
machine.

7. Lower the new belt unit into place, with the drive gear towards the rear of the 
printer. Locate the drive gear into the gear inside the printer by the rear right corner 
of the unit, and lower the belt unit flat inside the printer.

8. Push the locking levers towards the rear of the machine. This will secure the belt 
unit in place.

CAUTION!

The green image drum surface at the base of each cartridge is very 
delicate and light sensitive. Do not touch it and do not expose it to 
normal room light for more than 5 minutes. If the drum unit needs 
to be out of the printer for longer than this, please wrap the 
cartridge inside a black plastic bag to keep it away from light. 
Never expose the drum to direct sunlight or very bright room 
lighting.

b

a

a
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9. Holding the image drum assembly by its handles, lower it into place in the machine, 
locating the pegs at the sides into their slots in the sides of the printer cavity.

10. Close the output tray and press down firmly so that the cover latches closed.

11. Gently lower the scanner.
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FUSER REPLACEMENT

The fuser is located inside the printer just behind the toner cartridges.

Switch off the MFP and allow the fuser to cool for about 10 minutes before opening the 
cover. Refer to “Turning off your machine” on page 19 for details.

1. Gently raise the scanner.

2. Press the cover release (a) and open the output tray (b) fully.

3. Identify the fuser handle (a) on the top of the fuser unit.

4. Pull the two fuser retaining levers (b) towards the front of the printer so that they 
are fully upright.

5. Holding the fuser by its handle (a), lift the fuser straight up and out of the printer. If 
the fuser is still warm, place it on a flat surface which will not be damaged by heat.

6. Remove the new fuser from its packaging and remove the transit material.

WARNING!

If the MFP has recently been powered on, some fuser components 
will be very hot. Handle the fuser with extreme care, holding it only 
by its handle, which will only be mildly warm to the touch. A 
warning label clearly indicates the area.

a

b

b

b
a
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7. Holding the new fuser by its handle, make sure that it is the correct way round. The 
retaining levers (b) should be fully upright, and the two locating lugs (c) should be 
towards you.

8. Lower the fuser into the printer, locating the two lugs (c) into their slots in the sides 
of the printer cavity.

9. Push the two retaining levers (b) towards the rear of the printer to lock the fuser in 
place.

10. Close the output tray and press down firmly so that the cover latches closed.

11. Gently lower the scanner.

b

bc

b

b
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CLEANING

...THE UNIT CASING

1. Switch the printer off. Refer to “Turning off your machine” on page 19 for details.

2. Wipe the unit surface with a soft cloth moistened sparingly with water or neutral 
detergent.

3. Use a soft dry cloth to dry the unit surface.

4. Switch the printer on.

...THE LED HEAD

Clean the LED heads when printing does not come out clearly, has white lines or when text 
is blurred.

There is no need to switch off the printer to clean the lens.

1. Gently raise the scanner.

2. Press the cover release (a) and open the output tray (b) fully.

CAUTION!

Use a clean, moist, lint-free cloth for cleaning. Do not use benzine, 
thinners or alcohol as a cleaning agent.

a

b
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3. Gently wipe the LED head surface with a clean, lint free cloth.

4. Close the output tray and press down firmly at both sides so that the cover latches 
closed. 

5. Gently lower the scanner.

CAUTION!

Do not use methyl alcohol or other solvents on the LED head as 
damage to the lens surface will occur.
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...THE PAPER PATH IN THE ADF
If marks are found on an image which has been read by the ADF, or the ADF does not feed 
documents smoothly, follow the cleaning procedure below.

1. Switch the MFP OFF. Refer to “Turning off your machine” on page 19 for details.

2. Open the ADF top cover.

3. Moisten a soft, clean, lint-free cloth and wipe the feed rollers (1) by moving the cloth 
from side to side.

4. Rotate the rollers forward with your finger and repeat step 3 until the rollers are 
clean.

5. Carefully lift inner cover (2).

6. Wipe rollers (3 & 4) by moving the cloth from side to side.

7. Rotate the rollers forward with your finger and repeat step 6 until the rollers are 
clean.

8. Wipe the guide (5) from side to side.

9. Wipe the rubber pad (6) and rubber sheet (7) from side to side.

10. Return the inner cover to its original position.

11. Close the ADF top cover.

...THE UNDERSIDE OF THE ADF
1. Open the document cover.

2. Moisten a soft, clean, lint free cloth and remove any marks, as shown.

3. Close the document cover.

1

3
5

4

2
6

7
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...THE DOCUMENT GLASS

The document glass needs to be cleaned occasionally to ensure optimum image quality and 
performance.

1. Open the document cover.

2. Moisten a soft, clean, lint free cloth and remove any marks, as shown.

3. Close the document cover.
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INSTALLING UPGRADES
This section explains how to install optional equipment into your MFP. This includes:

> additional paper tray

ADDITIONAL PAPER TRAY

1. Switch the MFP off and disconnect the power cable. Refer to “Turning off your 
machine” on page 19 for details.

2. Place additional paper tray on desired location.

3. Observing safety rules for lifting and, using locating guides, place machine on top of 
the additional paper tray.

Model Number: N34311A

4. Fit retaining clips as shown.

5. Reconnect the power cable and switch the MFP on.

All that remains is to adjust the printer driver to make full use of the new features 
(“Setting the driver device options” on page 125).
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SETTING THE DRIVER DEVICE OPTIONS

Once your new upgrade has been installed, you may need to update the printer driver so 
that the additional features are available to your applications.

Accessories such as additional paper trays will only be usable if the printer driver on your 
computer knows they are there.

In some cases the hardware configuration of your machine is automatically detected when 
the driver is installed. However, it is advisable to at least check whether all of the available 
hardware features are listed in the driver.

This procedure is essential if you subsequently add extra hardware features to your 
machine after the drivers have been installed and set up.

Remember that if your machine is shared between users on different computers, the driver 
must be adjusted on each user’s machine.

WINDOWS

1. Access the driver’s Properties window.

(a) Open the “Printers” window via the Start Menu or from the Windows Control 
Panel.

(b) Right-click the icon for this machine, and choose the “properties” option from 
the pop-up menu.

2. Select the “Device” tab.

3. Set the options for any devices you have just installed.

4. Click OK to close the window and save your changes.

MAC OS X
1. Open the Mac OS X (For Mac OS X 10.8 Print & Scan) Preferences.

2. Ensure your machine is selected.

3. Click Options & Supplies.

4. Click Driver.

5. Select all hardware options appropriate to your machine and click OK.
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TROUBLESHOOTING

CHECKING THE MACHINE’S STATUS

From the STATUS key on the control panel, you can check the status of your machine.

The STATUS key illuminates or flashes when any trouble is occurring in your machine.
1. Press the STATUS key on the control panel to open the status menu.
2. Ensure that System Status is selected and then press OK.
3. Using the arrow keys, scroll to the item you want to check and then press OK.

CHECKING THE DEVICE AND JOB STATUS

You can check the device status, such as the residual life of the consumable items, and job 
lists from the STATUS key.
1. Press the STATUS key on the control panel to open the status menu.
2. Using the Down arrow key, scroll to Device Information and then press OK.
3. Using the arrow keys, scroll to the item you want to check and then press OK. 

Choose from:
> Copy/Print: Displays the list of copy/print jobs currently stored in the machines 

memory.
> Fax Job View/Cancel: displays the list of fax jobs currently stored in the 

machine’s memory.
> Supplies Status: Displays consumable status information.
> Counter:

Print Count: Displays the print count from all available trays.
Scan Count: Displays the number of pages scanned from the flatbed and ADF.

CHECKING THE LED INDICATOR IN THE POWER SWITCH 
If the LED indicator in the power switch is blinking at high speed per about 0.3 seconds, 
the machine may be malfunctioning.
Please unplug the AC cord immediately, and contact your dealer.
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CLEARING PAPER JAMS

Provided that you follow the recommendations in this guide on the use of print media, and 
you keep the media in good condition prior to use, your MFP should give years of reliable 
service. However, paper jams occasionally do occur, and this section explains how to clear 
them quickly and simply.

Jams can occur due to paper misfeeding from a paper tray or at any point on the paper 
path through the MFP. When a jam occurs, the machine immediately stops, and the 
STATUS LED on the control panel informs you of the event. 

If printing multiple pages (or copies), do not assume that, having cleared an obvious sheet, 
others will not also be stopped somewhere along the path. These must also be removed in 
order to clear the jam fully and restore normal operation.

IN THE SCANNER ADF SECTION...
If a sheet is well advanced out of the ADF, simply grip it and pull gently to draw it fully out.

1. Lift the ADF cover (1).

2. Remove any loose paper from the entry to the sheet feeder.

3. If there is any paper trapped in the feed mechanism:

(a) Lift the feeder mechanism (2).

(b) Remove any paper from ADF mechanism.

4. Lower the ADF cover (1).

5. Press the STOP button to restore the scanning head to the correct position.

NOTE
You can also refer to the instructions on how to clear paper jams by pressing 
the ?HELP key on the control panel while the error message is displayed.

NOTE
If it does not remove easily, do not use excessive force.

2

1
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IN THE PRINTER SECTION...
1. If a sheet is well advanced out of the top of the printer, simply grip it and pull gently 

to draw it fully out. If it does not remove easily, do not use excessive force. It can be 
removed from the rear later.

2. Gently raise the scanner.

3. Press the cover release (a) and open the output tray (b) fully.

4. Holding it by its handles, lift the image drum assembly, complete with the toner 
cartridges, up and out of the printer.

WARNING!

If the MFP has been powered on, the fuser will be hot. This area is 
clearly labelled. Do not touch.

a

b
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5. Put the assembly down gently onto a piece of paper to prevent toner from marking 
your furniture and to avoid damaging the green drum surface, and cover.

CAUTION!

The green image drum surface at the base of the Image Drum is 
very delicate and light sensitive. Do not touch it and do not expose 
it to normal room light for more than 5 minutes. If the drum unit 
needs to be out of the printer for longer than this, please wrap the 
cartridge inside a black plastic bag to keep it away from light. 
Never expose the drum to direct sunlight or very bright room 
lighting.
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6. Look into the printer to check whether any sheets of paper are visible on any part of 
the belt unit.

(a) To remove a sheet with its leading edge at the front of the belt (a), lift the 
plastic guard (e) at the front of the printer, then carefully lift the sheet from the 
belt and pull it forwards into the internal drum cavity and withdraw the sheet.

(b) To remove a sheet from the central area of the belt (b), carefully separate the 
sheet from the belt surface and withdraw the sheet.

(c) To remove a sheet just entering the fuser (c), separate the trailing edge of the 
sheet from the belt, push the fuser pressure release lever (d) towards the front 
and down to release the fuser’s grip on the sheet, and withdraw the sheet 

CAUTION!

Do not use any sharp or abrasive objects to separate sheets from 
the belt. This may damage the belt surface.

d

e

c

b

a

2

1
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through the drum cavity area. Then allow the pressure release lever to rise 
again.

(d) To remove a sheet in the fuser, move the two retaining levers (e) towards the 
front of the machine to release the fuser. Withdraw the fuser unit using the 
handle (f).

(e) Press release lever (g) and pull the trapped paper from the fuser.

NOTE
If the sheet is well advanced into the fuser (only a short length is still visible), 
do not attempt to pull it back.

d

f

e

e

g
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(f) Replace fuser unit into the machine and move locking levers (e) toward the rear 
of the machine.

7. If you were duplex printing when the jam occurred, check the duplex paper path:

(a) Pull the locking levers at each side of the transfer belt up and towards the front 
of the machine.

(b) Using the locking levers (a), lift the belt (b) upwards and withdraw from the 
machine.

(c) Look into the printer to check whether any sheets of paper are visible on any 
part of the paper path. Pull out any sheets found in this area.

NOTE
Check that there is no paper remaining inside the machine. 

Remove the paper carefully so that it does not tear. If the paper tears, be sure 
to remove all of the pieces. 

e

e

b

a

a
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(d) Lower the belt unit into place, with the drive gear towards the rear of the printer. 
Locate the drive gear into the gear inside the printer by the rear right corner of 
the unit, and lower the belt unit flat inside the printer.

(e) Push the locking levers towards the rear of the machine. This will secure the belt 
unit in place.

8. Holding the image drum assembly by its handles, lower it into place in the machine, 
locating the pegs at the sides into their slots in the sides of the printer cavity.

9. Lower the output tray but do not press down to latch it closed yet. This will protect 
the drum from excessive exposure to room lighting while you check the remaining 
areas for jammed sheets.

10. Open the rear exit tray (h) and check for a sheet of paper in the rear path area (i).

> Pull out any sheets found in this area.

h

i
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> If the sheet is low down in this area and difficult to remove, it is probably still 
gripped by the fuser. In this case raise the output tray, reach around and press 
down on the fuser pressure release lever (d).

11. If you are not using the rear exit tray, close it once any paper has been removed 
from this area.

12. Pull out the paper tray and ensure that all paper is stacked properly, is undamaged, 
and that the paper guides are properly positioned against the edges of the paper 
stack. When satisfied, replace the tray.

13. Close the output tray and press down firmly so that the cover latches closed.

14. Gently lower the scanner.

When the jam has been cleared, if Jam Recovery is enabled in the Printer Adjust menu, 
the MFP will attempt to reprint any pages lost due to paper jams.

d
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DEALING WITH UNSATISFACTORY PRINTING 

SYMPTOMS POSSIBLE CAUSES STEPS TO TAKE

Vertical white lines can 
be seen on the printed 
page.

The LED head is dirty. Wipe the LED head with a soft, 
lint-free cloth.

The toner is low. Open the output tray and tap the 
cartridge a few times to evenly 
distribute any remaining toner. If 
symptoms persist, replace the 
toner cartridge.

Foreign materials may be 
present in the image drum.

Replace the image drum 
cartridge.

Light-shielding film of the 
image drum cartridge is dirty.

Wipe the film with a soft, lint-
free cloth.

Printed images are 
fading vertically.

The LED head is dirty. Wipe the LED head with a soft, 
lint-free cloth.

The toner is low. Open the output tray and tap the 
cartridge a few times to evenly 
distribute any remaining toner. If 
symptoms persist, replace the 
toner cartridge.

The paper is not suitable for 
the printer unit.

Use recommended paper.

Printing is light. The toner cartridge is not 
properly seated.

Reinstall the toner cartridge.

The toner is low. Open the output tray and tap the 
cartridge a few times to evenly 
distribute any remaining toner. If 
symptoms persist, replace the 
toner cartridge.

The paper is moist. Use paper stored in proper 
temperature and humidity 
conditions.

The paper is not suitable for 
the printer unit.

Use recommended paper.

Thickness and type of paper 
are inappropriate.

Set the correct value of media 
type and media weight in the 
Media menu or set one value 
thicker for media weight.

Recycled paper is being used. Set one value thicker for media 
weight in the Media menu.

Partially faded images. 
White spots and lines 
appear in solid 
printing.

Paper is moist or dry. Use paper stored in proper 
temperature and humidity 
conditions.

Vertical lines appear. The image drum cartridge is 
damaged.

Replace the image drum 
cartridge.

The toner is low. Open the output tray and tap the 
cartridge a few times to evenly 
distribute any remaining toner. If 
symptoms persist, replace the 
toner cartridge.
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DEALING WITH UNSATISFACTORY COPYING

As well as the suggestions provided in “Dealing with unsatisfactory printing” on page 135, 
ensure that the scanner unit glass is clean at all times. Refer to “Cleaning” on page 120.

Horizontal Lines and 
spots appear 
periodically.

When the interval is about 
94mm (4in), the image drum 
(the green tube) is damaged 
or dirty.

Wipe it lightly with a soft cloth. 
Replace the image drum 
cartridge when it is damaged.

When the interval is about 
30mm (1.2in), there may be 
foreign particles in the image 
drum cartridge.

Open/close the output tray, and 
print again.

When the interval is about 
86mm (3.4in), the fuser unit 
is damaged.

Replace the fuser unit.

The image drum cartridge 
has been exposed to light.

Replace the image drum 
cartridge if the problem is not 
resolved.

White area of paper is 
lightly stained.

Paper contains static. Use paper stored in proper 
temperature and humidity 
conditions.

Too thick paper is used. Use thinner paper.

The toner is low. Open the output tray and tap the 
cartridge a few times to evenly 
distribute any remaining toner. If 
symptoms persist, replace the 
toner cartridge.

Periphery of the letters 
is smudged.

The LED head is dirty. Wipe the LED head with a soft, 
lint-free cloth.

Toner comes off when 
it is rubbed.

The thickness and type of the 
paper are incorrectly set.

Set the correct value of media 
type and media weight in the 
Media menu or set one value 
lighter for media weight.

Recycled paper is used. Set one value thicker for media 
weight in the Media menu.

Glossiness is not 
uniform.

The thickness and type of the 
paper are incorrectly set.

Set the correct value of media 
type and media weight in the 
Media menu or set one value 
lighter for media weight.

All pages are not 
printed.

WSD port is used. Change the port to the standard 
TCP/IP port.

SYMPTOMS POSSIBLE CAUSES STEPS TO TAKE
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FAX PROBLEM CHECKLIST

If a problem occurs, read through the list of problems and solutions before calling for 
service.

The machine will not dial a telephone number: Check the power cable and wall outlet. 
Make sure that the telephone line (not external telephone or handset) is connected to the 
LINE socket on the back of the machine. If an external telephone is installed, lift the 
handset and check for a dial tone. If there is no dial tone, there may be a problem with the 
telephone line. If there is a dial tone, the machine may be using the wrong dialling method 
(pulse or tone) for the region. If alternating tones are heard instead of dialling pulses and 
the region uses pulse dialling, change the call parameters.

The display shows a communications error: This indicates any of a number of 
problems.

> The machine may be incompatible with the remote machine, or the remote machine 
may not be able to perform the function requested of it such as polling or 
confidential faxing. 

> The remote machine may also be out of paper or experiencing a paper jam. 

> Bad telephone line conditions can also cause communication errors. Try sending the 
fax again and check to make sure that the correct telephone number is being dialled.

> If a prefix number must be dialled to get an outside line, or if the call is to an 
international destination, a pause may need to be entered after the dial prefix or 
international dialling code to tell the machine to wait for a dial tone. If there are 
frequent problems communicating with a particular remote machine, try 
programming the number into a speed dial key, and then change the parameters for 
that key.

> Lastly, either the local or remote machine may require servicing. Try sending a fax to 
another location to check the local machine.

Faxing is possible but the image of the document printed by the remote machine 
is very poor: If the faxed document has small type, complex illustrations, photos, or is 
very light or very dark, try changing the fax density settings. Copy the document on the 
machine to determine how it will transmit. The problem may be caused by telephone line 
interference. Try sending the document again later.

Fax sent but received message was completely blank: Make sure that the document 
is loaded correctly before faxing; with text face UP in the ADF or face DOWN on the glass.

Image of received fax is very poor: Try making a copy of a document on the local 
machine to make sure it is working properly. If there is still a problem, contact the person 
sending the fax and ask them to change their fax quality and density settings. Ask the 
person to make a copy of the document on their machine to ensure that it is working 
properly. Then ask them to send the fax again.

Dialling was tried with a Speed Dial/Group Dial number but nothing happened: 
Make sure that the Speed Dial number being used is programmed correctly.

Documents received are light or have vertical streaks on them, and machine is not 
out of toner: Gently wipe the lens surface of the MFP's LED array, and then check to see 
if the machine is working properly (see “...the LED head” on page 120). Then check to see 
if the toner or image drum need replacing (see “Replacing consumable items” on 
page 110).

Machine is set for delayed transmission but it did not send: Check the display to 
make sure that the MFP is set to the correct time and date.

MFP will not poll a remote machine.: Call the person at the remote machine and make 
sure that they have loaded documents and that their machine is set to polling transmission 
mode.
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Machine is connected to a PBX but it is not possible to dial out: Be certain that the 
dial prefix is entered before the telephone number for each number dialled or programmed 
into the machine. Additionally, the machine must be programmed for PBX operation before 
it will work with a PBX (refer to the Configuration Guide for details).

Machine always answers before it’s possible to use the external telephone: If an 
external telephone is connected, increase the machine’s ring response setting.

Faxes received sometimes look distorted: If the document received is wider or longer 
than the paper loaded in the paper tray, the machine automatically reduces the width or 
length of the document so that it will fit on the paper. This type of problem could also be 
communication related.
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BEFORE MACHINE DISPOSAL
Before this machine is disposed of, it is recommended to erase the registered privacy data 
and the stored data.

The data stored in the machine is shown below.

> Address book

> Phone book

> Profile

> Registered data in one touch button or the like

> Admin password

> Registered settings in various menus

> Fax data

> Private printing data

> Various records

> Access control, user management data (local user, external user cache LDAP, and 
Kerberos)

1. Press the SETTING button on the operator panel.

2. Press the scroll button  to select Admin Setup, and press the OK button.

3. Input the admin password.

4. Select User Install > Erase Privacy Data.

5. Select Yes, and press the OK button.

6. Once Are You Sure? is displayed, select Yes, and press the OK button.

7. Once Would you like really? is displayed, select Yes, and press the OK button.
Restart the machine to erase the data.

NOTE
Once the action is executed, the erased data cannot be restored. To cancel the 
erasing, select No in Step 6 or Step 7.
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SPECIFICATIONS

MFP model Model Number

MC363dn N34346A, N34346B

ITEM MC363dn

Dimensions 427 x 509 x 445mm (W x D x H)

Weight 29Kg approx.

Power supply 110 to 127VAC, 50/60Hz±2%
220 to 240VAC, 50/60Hz±2%

Power consumption  Off: <0.5 W

Sleep: <1.5 W

Power saving: < 20 W

Stand-by: 100 W

Operating (Average): 570 W

Operating (Max.): 1170 W

Operating environment Operating 10 to 32 °C/20 to 80% RH
(optimum 25 °C wet, 2 °C dry)
Idle: 0 to 43 °C/10 to 90% RH

(optimum 26.8 °C wet, 2 °C dry)

Print environment color 17 to 27 °C @ 50 to 70% RH

Noise (Sound pressure level) Operating (Print): 52dB(A)

Operating (Copy): 54dB(A)

Standby: Inaudible

Power saving: Inaudible
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Regulatory wireless LAN statements

-FCC Statement

-IC Statement

-Europe-CE Declaration of conformity.

FCC statement

IC statement

Caution (FCC/IC):

FCC WARNING
Changes or modifications not expressly approved by the party responsible for compliance could 
void the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment generates, 
uses and can radiate radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does 
cause hamful interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures:
-Reorient or relocate the receiving antenna.
-Increase the separation between the equipment and receiver.
-Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.
-Consult the dealer or an experienced radio/TV technician for help.

This transmitter must not be co-located or operating in conjunction with any other antenna or 
transmitter.

This device complies with Part 15 of FCC Rules and Industry Canada licence-exempt RSS stan-
dard(s). Operation is subject to the following two conditions: (1) this device may not cause 
interference, and (2) this device must accept any interference, including ingerference that may 
cause undesired operation of this device.

Le présent appareil est conforme aux la partie 15 des règles de la FCC et CNR d’Ubdustrie Can-
ada applicables aux appareils radio exempts de licence. L’exploitation est autorisée aux deux 
conditions suivantes : (1) I’appareil ne doit pas produire de brouillage, et (2) I’utilisateur de 
I’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible 
d’en compromettre le fonctionnement.

This Class [B] digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe [B] est conforme à la norme NMB-003 du Canada.

5.15-5.25GHz band is restricted to indoor operations only.

La bande 5 150-5 250 MHz est restreints à une utilisation à l’intérieur.

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled 
environment and meets the FCC radio frequency (RF) Exposure Guidelines and RSS-102 of the 
IC radio frequency (RF) Exposure rules. This equipment should be installed and operated keep-
ing the radiator at least 20cm or more away from person’s body.

Cet équipement est conforme aux limites d’exposition aux rayonnements énoncées pour un 
environnement non contrôlé et respecte les règles les radioélectriques (RF) de la FCC lignes 
directrices d'exposition et d’exposition aux fréquences radioélectriques (RF) CNR-102 de l’IC. 
Cet équipement doit être installé et utilisé en gardant une distance de 20 cm ou plus entre le 
dispositif rayonnant et le corps.
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Europe - CE Declaration of Conformity

This equipment complies with the essential requirements of the European Union directive 1999/5/EC.

The telecommunications functionality of this product may be used in the following EU and EFTA 
countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, 
France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, 
Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, 
Slovenia, Spain, Sweden, Switzerland, Turkey and United Kingdom.
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OKI CONTACT DETAILS
OKI Systems (UK) Ltd.
Blays House
Wick Road
Egham
Surrey
TW20 0HJ
Tel: +44 (0) 1784 274300
Website: www.oki.com/uk

OKI Systems (Ireland) Ltd
A7 Calmount Park 
Ballymount 
Dublin 12  
D12 TX94 
Ireland
Tel: +353 (0) 1 4049590
Fax: +353 (0)1 4049591
Website: www.oki.com/ie

OKI Systems (Czech and Slo-
vak), s.r.o.
Futurama Business Park - 
Sokolovská 651/136A
186 00 Praha 8
Czech Republic
Tel: +420 224 890158
Fax:+420 22 232 6621
Website: www.oki.cz, www.oki.sk

Oki Systems (Deutschland) 
GmbH
Hansaallee 187
40549 Düsseldorf
Tel: +49 (0) 211 / 5266-0
Fax: +49 (0) 211 59 33 45
Website: www.oki.de

Albania, Bosnia, Bulgaria, Croatia,
Cyprus, Estonia, Greece, Israel, 
Latvia, Lithuania, Macedonia, 
Romania, Serbia, Slovenia 

CEE Export Group:  
OKI Systems (Poland) Sp. z o.o.
Platinum Business Park 2, 3rd Floor 
ul. Domaniewska 42, 02-672 Warsaw
Poland

Tel: +48 (0) 22 448 65 00
Fax: +48 (0) 22 448 65 0
Website: www.oki.pl

Oki Systèmes (France) S.A.
Zone Silic - Immeuble Osaka
21 rue du Jura
CS 90277
94633 RUNGIS Cedex 
Paris
Tél: Standard 0820 200 410 

Hotline  01 76 54 21 50 (n° non 
surtaxé)
Website: www.oki.fr

OKI Systems (Magyarország) 
Kft.
H-1133 Budapest,
Váci út 76
Hungary
Telefon: +36 1 814 8000
Telefax: +36 1 814 8009
Website: www.okihu.hu

OKI Systems (Italia) S.p.A.
via Milano, 11,
20084 Lacchiarella (MI)
Tel: +39 (0) 2 900261
Fax: +39 (0) 2 90026344
Website: www.oki.it

OKI Systems (Polska) Sp. z o.o
Platinium Business Park II, 3rd
Floor
ul. Domaniewska 42
02-672 Warsaw
Poland
Tel: +48 22 448 65 00  
Fax: +48 22 448 65 01
Website: www.oki.pl
E-mail: oki@oki.com.pl
Hotline: 0800 120066
E-mail: tech@oki.com.pl

OKI Europe Limited, Sucursal 
em Portugal
Av. Quinta Grande 53
7º D Alfragide
2614-521 Amadora
Portugal
Tel: +351 21 470 4200
Fax: +351 21 470 4201
Website:www.oki.pt
E-mail : oki@oki.pt

Oki Service 
Serviço de apoio técnico ao
Cliente
Tel: 214 727 660
E-mail : okiserv@oki.pt

OKI Systems Rus, LLC (Russia)
Sector B, 3rd Floor, Svyatogor-4 
Business Center10/4, Letnikovskaya 
str.115114, Moscow
Tel: +7 495 276 5060
Fax: +7 495 258 6070
e-mail: info@oki.ru
Website: www.oki.ru
Technical support:
Tel: +7 495 564 8421
e-mail: tech@oki.ru

Oki Systems (Österreich)
Campus 21
Businesszentrum Wien Sued
Liebermannstrasse A02 603
22345 Brun am Gebirge
Tel: +43 223 6677 110
Service-Hotline: 
+43 (0) 2236/677 110-501
Website: www.oki.at

OKI Europe Ltd. (Ukraine)
Raisy Opkinoy Street,8
Building B, 2nd Floor,
Kiev 02002
Ukraine
Tel: +380 44 537 5288
e-mail: event@oki.ua
Website: www.oki.ua

OKI Sistem ve Yazıcı Çözümleri 
Tic. Ltd. Şti.
Harman sok Duran Is Merkezi,
No:4, Kat:6,
34394, Levent
İstanbul
Tel: +90 212 279 2393
Faks: +90 212 279 2366
Web: www.oki.com.tr

Oki Systems (Belgium)
Medialaan 24
1800 Vilvoorde
Helpdesk: 02-2574620
Fax: 02 2531848
Website: www.oki.be

OKI Systems (Danmark) a·s 
Herstedøstervej 27
2620 Albertslund
Danmark
Adm.: +45 43 66 65 00
Fax: +45 43 66 65 90
E-mail: salg@oki.dk / 
support@oki.dk
Website: www.oki.dk

OKI Europe Limited, Sucursal en
España
Complejo Vega Norte. C/ Anabel 
Segura, 16. Edif. 3 – 4º Plta.
28.108, Alcobendas  
Madrid
Tel +34 91 343 16 20
Website: www.oki.es
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OKI Middle East, India and Sub 
Sahara Africa 
Building 7W A 

Dubai Airport Free Zone 
PO Box 54604 
Dubai, UAE
Tel: +971 4 204 5810
Website: www.oki.com/me

Oki Systems (Finland) Oy
Vänrikinkuja 3
02600 Espoo
Tel: +358 (0) 207 900 800
Fax: +358 (0) 207 900 809

Oki Systems (Holland) b.v.
Neptunustraat 27-29
2132 JA Hoofddorp
Helpdesk: 0800 5667654
Tel: +31 (0) 23 55 63 740
Fax: +31 (0) 23 55 63 750
Website: www.oki.nl

Oki Systems (Norway) AS
Tevlingveien 23
N-1081 Oslo
Tel: +47 (0) 63 89 36 00
Telefax: +47 (0) 63 89 36 01
Website: www.oki.no
Var vänlig kontakta din 
Återförsäljare i första hand, för 
konsultation. I andra hand kontakta

Oki Systems (Sweden) AB
Box 1193
164 26 Kista
Tel. +46 (0) 8 634 37 00
e-mail: info@oki.se 
Website: www.oki.se

Oki Systems (Schweiz)
Baslerstrasse 15
CH-4310 Rheinfelden
Support deutsch +41 61 827 94 81
Support français +41 61 827 94 82
Support italiano +41 061 827 9473

Tel: +41 61 827 9494
Website: www.oki.ch

Oki Data Americas Inc.(United 
States • États-Unis)
2000 Bishops Gate Blvd.
Mt. Laurel, NJ 08054
USA
Tel: 1-800-654-3282
Fax: 1-856-222-5247
http://WWW.OKIPRINTINGSOLUTIONS.COM
http://my.okidata.com
8505 Freeport Pkwy
Suite 100
Irving, TX 75063
http://www.okidata.com
2067 Wineridge Place
Suite C & D
Escondido, CA 92029
Phone: 760-781-5200
Toll Free: 800-264-1272
http://www.okidata.com/wide-format

Oki Data Americas Inc.(Canada 
• Canadá)
4140B Sladeview Crescent Unit 7 & 8
Mississauga, Ontario
Canada L5L 6A1
Tél: 1-905-608-5000
Téléc: 1-905-608-5040
http://WWW.OKIPRINTINGSOLUTIONS.COM

Oki Data Americas Inc.(América 
Latina (OTRO))
2000 Bishops Gate Blvd.
Mt. Laurel, NJ 08054
USA
Tel (Español): 1-856-222-7496
 1-856-222-5276
Fax: 1-856-222-5260
Email: LASatisfaction@okidata.com

Oki Data de Mexico, S.A. de C.V.
Mariano Escobedo #748, Piso 8
Col. Nueva Anzures
C.P. 11590, México, D.F.
Tel: 52-555-263-8780
Fax: 52-555-250-3501
http://WWW.OKIPRINTINGSOLUTIONS.COM

Oki Data do Brasil Informática 
Ltda.
Av. Alfredo Egídio de Souza Aranha, 
100 - 5º Andar - Bloco C
Chácara Santo Antonio - São Paulo, 
SP - Brasil
CEP: 04726-170

Tel: 55-11-3543-5500
Fax: 55-11-3444-3501
email: okidata@okidata.com.br
HTTP://www.okiprintingsolutions.com

Argentina/Chile/Paraguay/Perú/
Uruguay
Oki Data Americas, Inc.
Sucursal Argentina
Ugarte 3610 Piso 4°(1605) Olivos
Buenos Aires, Argentina

TEL: +54 11 5288 7500
Fax: +54 11 5288 7599

Colombia/Ecuador/Venezuela/
Centroamérica y Caribe
Oki Data Americas, Inc.
Sucursal Colombia

Bogotá Colombia

TEL: +57 1 704 5159

Oki Data (Singapore) Pte. Ltd.
438A Alexandra Road #02-11/12,
Lobby 3, Alexandra Technopark
Singapore(119967)
Tel: (65) 6221 3722
Fax: (65) 6594 0609
http://www.okidata.com.sg

Oki Systems (Thailand) Ltd.
1168/32 Lumpini Tower,
16th Floor, Rama IV Road,
Tungmahamek, Sathorn
Bangkok 10120
Tel: (662) 679 9235
Fax: (662) 679 9243/245
http://www.okisysthai.com

Oki Data(Australia) Pty Ltd.
Level1 67 Epping Road, Macquarie 
Park
NSW 2113, Australia
Tel: +61 2 8071 0000
(Support Tel: 1800 807 472)
Fax: +61 2 8071 0010
http://www.oki.com.au

OKI Data New Zealand
8 Antares Place Rosedale,
Auckland, 0632 New Zealand
Tel: (64) 9 477 0500
(Customer Support: 0800 778 800)
Fax: (64) 9 477 0549
http://www.oki.co.nz/

Suite 21.03, 21st Floor Menara IGB,
Mid Valley City,
Lingkaran Syed Pura 59200,
Kuala Lumpur, Malaysia
Tel: (60) 3 2287 1177
Fax: (60) 3 2287 1166



46472802EE Rev2
www.oki.com/printing/

4-11-22 Shibaura, Minato-ku,Tokyo 
108-8551, Japan 


	Preface
	Emergency first aid
	Manufacturer
	Importer to the EU/authorised representative
	Environmental information
	Contents
	Notes, cautions and warnings
	About this guide
	Documentation suite
	Purpose of this guide
	On-line usage
	Printing pages

	Introduction
	Overview
	Front view
	Rear view

	Control panel
	Keypad - character switching
	Changing the display language

	Getting started
	Turning on your machine
	Turning off your machine
	When the machine is not used for long time

	Power saving mode
	Sleep mode
	Auto power off
	Installing drivers and utilities
	Windows - scanner and printer drivers
	Mac - printer driver
	Fax driver
	Configuration tool
	ActKey utility


	Paper recommendations
	Cassette trays
	Multi purpose tray
	Output tray
	Rear output tray
	Duplex

	Loading paper
	Cassette trays
	Multi purpose tray
	Configuring the tray settings
	Registering custom sizes

	User authentication and access control
	PIN authentication
	Logging into the machine
	Logging out of the machine

	User name and password authentication
	Logging into the machine
	Logging out of the machine
	Operation from the computer


	Operation
	Multi-tasking
	Loading document(s)
	Document requirements
	Scannable area
	Placing document(s) in the ADF
	Placing document(s) on the glass


	Copying
	Basic operation
	Increasing copy count

	Advanced operation
	Resetting copy settings
	Auto reset
	Using the reset/logout button


	Scanning
	Installing scanner drivers (TWAIN/WIA/ICA driver)
	Installation procedure
	Using ActKey software

	Setup to use the WSD Scan
	Installation procedure

	Scanning methods
	Scan to E-mail
	Scan to Shared Folder
	Scan to USB memory
	Scan to Computer
	Connecting VIA USB
	Connecting VIA Network
	WSD Scan connection

	Remote Scan
	Simple scan mode
	Manual scan mode
	Secure scan mode (for network connection)
	Secure scan mode (for USB connection)

	Managing profiles
	Adding a new network profile
	Deleting a network profile

	Managing the address book
	Setting sender and reply to E-mail addresses (from/reply to)
	Creating E-mail templates
	Adding an E-mail address entry to the address book
	Deleting an E-mail address entry from the address book
	Modifying an E-mail address entry from the address book
	Adding a group entry to the address book
	Deleting a group address entry from the address book
	Modifying a group address entry from the address book


	Printing
	Job lists
	Print from USB memory
	Basic operation
	Advanced operation

	Switching online/offline
	Printing with AirPrint
	Products Affected
	How to print


	Faxing
	Sending a fax from the MFP
	Basic operation
	Advanced operation
	Fax receiving

	Managing the phone book
	Adding a speed dial entry to the phone book
	Adding a group entry to the phone book
	Deleting a speed dial entry from the phone book
	Deleting a group dial entry from the phone book
	Modifying a speed dial entry
	Modifying a group dial entry
	Registering an entry from reception or transmission history

	Internet fax
	Sending a fax from your PC
	Receiving an internet fax
	Adding fax numbers to the phone book
	Adding new groups to the phone book
	Importing and exporting fax numbers


	Functions common to copy, fax and scan operations
	Continuous scan mode

	Maintenance
	Replacing consumable items
	Toner cartridge replacement
	Image drum replacement
	Replacing the transfer belt unit
	Fuser replacement

	Cleaning
	...the unit casing
	...the LED head
	...the paper path in the ADF
	...the underside of the ADF
	...the document glass


	Installing upgrades
	Additional paper tray
	Setting the driver device options
	Windows
	Mac OS X


	Troubleshooting
	Checking the machine’s status
	Checking the device and job status
	Checking the LED indicator in the power switch
	Clearing paper jams
	In the scanner ADF section...
	In the printer section...

	Dealing with unsatisfactory printing
	Dealing with unsatisfactory copying
	Fax problem checklist

	Before Machine Disposal
	Specifications
	Index
	Oki contact details



